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Introduction
ASW2 is a software for work with semiconductor and scintillation spectrometers of gamma,
beta and alpha radiation (such as TRIO, BOSON, AirSPEC, GCD, MCA-527, DSPEC, etc.).
ASW2 ensures simultaneous and independent control of all the connected analysers and
spectrometric devices, and provides all the necessary tools for applied spectrometry. It allows
measuring and processing spectra, setting parameters of spectrometric tracts and determining all the
relevant metrological characteristics.
ASW2 employs different algorithms for determining activity in samples (ROI-method with
overdetermined matrix, individual peaks analysis method, superposition method). For the analysis of
high resolution spectra (spectra received on semiconductor spectrometers) there separate tools
(search peaks, Gaussian approximation, identification, making efficiency curves, etc.).
ASW2 has a multi-window, easily customisable interface and provides broad opportunities for
work with spectra (mathematical operations, pack processing, application of specific algorithms,
conversion and translation to other applications). Automation of routine measurements can be
implemented using a bar-code system and counter samples change mechanisms.
ASW2 has a platform and module structure, which allows supplementing the program with
application modules.
The program includes plug-in modules:
“Pack” – processing of series of spectra;
“Profile” – measurements in motion (car, railway car version of the spectrometer-radiometer);
“WBC” – whole body radiation spectrometry (in chair and chamber configuration).

System requirements:
Windows XP/Vista/7/8/10;
processor with frequency 1 GHz;
USB 2.0 (for MCA-527, BINOM, AMBER, BOSON, MD198, MD198M analyser)
256 MB RAM;
100 MB of free space on the hard drive;
keyboard;
mouse.
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1 Starting the program
To start ASW2, double click with the left mouse button on the ASW2 icon on the Windows
desktop, or go to Start->Programs->ASW2.

When the program is started, it detects enabled analysers and their status. If there are many
analysers, the starting process may last longer, and the detection progress can be seen on start-up
screen of the program. To terminate the connection with enabled analysers, press Esc key on the
keyboard.

2 Structure of the program and its elements
2.1 Main interface elements
When the program has started, the main window of the program will appear on the display
(Fig.1).
Block 1

Block 2
Block 3

Block 4

Figure 1. View of ASW2 after its launch
The program window contains four main blocks:
- main menu of the program (Block 1);
- main toolbar with buttons providing access to most used dialogues (Block 2);
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- device manager (Block 3) – a panel, which ensures switching from one spectrometric tract to
the other;
- status bar (Block 4).
2.2 Main menu
The main menu of the program includes the following items:
The menu item File (see Fig.2):

Figure 2. File menu items

With the Open Spectrum menu item, the user may open a previously saved spectrum in a
dialogue window.
in the main window’s toolbar (see Fig. 1, block
The same can be done by clicking button
2).
The following two or more menu options can be used to promptly open recently saved spectra.
The names of the menu options correspond to the names of the spectrum files.
Menu option Export to has a submenu which contains two options:
Excel sends the spectrum data to MS Excel;
Save as picture creates spectrum image as a *.jpg file.
Menu options Save spectrum and Save spectrum as save an opened and active spectrum as
a file with the default name or a new name to be specified, respectively.
The item Exit is used to close ASW2.
The menu item Tools (see Fig.3):
Figure 3. Tools menu items

Pack opens a window for working with several spectra (see section 11).
In the Tools section, you will see names of plug-in modules such as WBC, Profile, etc.
Item Database allows data base window opening, the file is specified in the window
Parameters at insert Files (see section 10).
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Item Scenarium will activate the window of module Scenarium, which allows execution of
so called script or sequences of operations in the program ASW2, as well as execute the quality
control for spectrometric sections and remote access to the program (see chapter 17).
The menu item Options s (see Fig.4):

Figure 4. Options menu item

Passport of source editor opens a window that allows generating files of passport data of
source (see section 13), used in the procedure of generation of efficiency calibration files.
Menu option Nuclide library editor opens a dialogue box to process radionuclides library
files, as well as create and edit user’s libraries based on the already existing libraries (see section
12).
Log opens a log window, which displays saved results of conducted measurements. Data can
(Options)
be sent to the log using Add to log in the menu, which can be displayed by pressing
on the toolbar of the spectrum.
Parameters opens a window with the same name, which contains general settings of the
program (see section 10).
Bar-code opens a window with information about the entered bar-code, from which
measurement with automatically completed information about the source can be started. You can
display such a window automatically by pressing the F5 hot key.
Library editor is for opening a dialogue, where you can work with radionuclides library files,
as well as create and edit your libraries using the existing ones (see section 12).
As Device manager (Block 3, Fig.1) can be separated from the left edge of the main program
window and can be closed, then Device manager can make this panel visible again.
Switch on analyser allows switching on all the available analysers at once. It means that if
analysers are physically connected to the PC and parameters of each connection are entered in the
program, with this item you can skip pressing Switch On in the Device configuration window (see
Fig. 11) for each spectrometric tract separately.
Use Russian/English to switch ASW2 interface language. When you use this item, the
program will warn you than a language will change and will close. When you reopen the program,
the interface language will be different.
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The menu item Window (see Fig.5):

Figure 5. Window menu items

Mosaic displays windows of the spectrum as a “Mosaic”. Cascade displays windows of the
spectrum as a “Cascade”. Minimize all minimizes all the windows of the spectrum to the bottom of
the main window.
Range measuring spectra ranges the spectra to be measured (those having a status
“measurement spectrum”) in the sequence of their opening.
Close all closes all the windows.
The menu item Help (see Fig.6):

Figure 6. Help menu items
Item About… brings a dialogue with information about ASW2, as well as contact
information.
Item Help displays information on how to work with the program.

2.3 Main toolbar
ASW2 toolbar looks as shown on Figure 1 (block 2). The panel is divided into groups, which
can be moved within the panel, or “separated” from the panel and moved to some other area of the
main window of the program.
The panel contains four groups (see Fig.7):

Figure 7. Groups of the toolbar
The first group Device manager contains the following buttons:
- Open spectrum activates a dialog box to open a spectrum;
- Device configuration, displays a configuration window of the analyser (device), which
is highlighted in the Device manager right now (Fig.1, block 3, Analysers column);
- Tract configuration, displays a configuration window of the spectrometric tract, which
is highlighted in the Device manager right now (Fig.1, block 3, Channels column);
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- Measurement parameters, displays a window with parameters of measurements for the
spectrometric tract, which is highlighted in the Device manager right now (Fig.1, block 3,
Channels column);
- Calculation parameters, displays a window with calculation (activity, etc.) parameters
for the spectrometric tract, which is highlighted in the Device manager right now (Fig.1, block 3,
Channels column);
- Spectrum view parameters, displays a window with parameters of the view of the
spectrum (colours of elements of the histogram, background, axes, etc.) for the spectrometric tract,
which is highlighted in the Device manager right now (Fig.1, block 3, Channels column).
The second group Calibrations contains the following buttons:
- Energy calibration, displays energy calibration for the tract, which is highlighted in the
Device manager right now (Fig.1, block 3, Channels column);
- FWHM and shape calibration, displays FWHM (full width at half maximum) and
shape (left edge shape) calibration of the peak for the tract, which is highlighted in the Device
manager (Fig.1, block 3, Channels column);
- Efficiency calibration, displays a window of efficiency calibration. The display of this
window is not related to the currently selected analyser and tract.
The third group Measurement is active only when there is a real connection with a real
analyser for the current tract. The group contains the following buttons:
- Start, starts a measurement in the spectrometric tract, which is highlighted in the Device
manager right now (Fig.1, block 3, Channels column). If the previous measurement has been
interrupted manually, the user will be asked if the buffer should be cleaned prior to starting the next
measurement;
- Stop, stops a measurement in the spectrometric tract, which is highlighted in the Device
manager right now (Fig.1, block 3, Channels column);
- Read, forced reading of the spectrum from an analyser for the current spectrometric
tract, which is highlighted in the Device manager right now (Fig.1, block 3, Channels column);
- Clear, clears spectrum buffer in the analyser for the current spectrometric tract, which
is highlighted in the Device manager right now (Fig.1, block 3, Channels column).
The toolbar buttons described above are duplicated in the Device manager popup. Thus, for
instance, the context menu of the Analysers column looks as shown on Fig.8.

Figure 8. Context menu of the Analysers column
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Also, the context menu of the Channels column looks as shown on Figure 9.

Figure 9. Context menu of the Channels column
The fourth group is named Option and contains the following buttons:
- Quality Assurance opens the dialog box to adjust the spectrometric tract and control
key metrological characteristics such as resolution, efficiency, background etc (see section 15);
- Nuclide library editor opens a dialogue box to process radionuclides library files, as
well as create and edit user’s libraries based on the already existing libraries (see section 12). This
button is similar to the same named button in the program’s main window;
- Passport of sources editor opens a dialog box to create source passport data files (see
section 13) used when creating efficiency calibration files. This button is similar to the same named
button in the program’s main window.
2.4 Device Manager panel
The Device Manager panel (Fig.1, block 3) is intended for switching between analysers
(devices) and tracts within a single analyser (if the analyser is multi-tract analyser). This solution
allows simultaneously and operatively controlling any number of devices connected to the PC and
spectrometric tracts, to start measurements and conduct processing.
To choose the necessary analyser and tract, just click on it with the left mouse button in the
table. When selecting a spectrometric tract in the Channels column, the analyser corresponding to it
is selected automatically. When clicking on the necessary analyser in the Analysers column, the
first tract will be selected automatically. (Example. On Fig.8 and 9 the current analyser is
'MCA527', the current tract is 'BDEG-63').
As it was noted above, button actions on the toolbar described in section 2.3 will be used for
the currently selected tract.
To add or remove an analyser to the Device Manager panel there are
and
buttons in
the table header (block 1). To remove an analyser from the list of used analysers, select the analyser
in the Analysers table and press
.

10

The Channels column is also divided into two columns, first of which is intended for
displaying the name of the tract, but the second has a timer showing the time of measurement left in
seconds. If the field is empty, measurement in the channel was stopped or has ended (see Fig. 10).

Timer to
the end of
measurement

Figure 10
2.4.1 Device configuration window
When you press
on the toolbar or select Device configuration in the context menu of the
Analysers column on the Device Manager panel, a window shown on Figure 11 will appear on the
display.

Figure 11. Device configuration window view
Analyser name field – the name of the analyser given by the user to the current analyser and
shown in the Analysers column on the Device Manager panel.
Analyser type field – the type of the analyser from the list of ASW2 - compatible devices.
Address, Port fields – intended for specifying an analyser’s IP address in the network, or a
device address on the bus, or a serial port number (including virtual) depending on the type of the
device. If the field Address is not empty, the software attempts to establish connection with the
analyzer which has the corresponding IP address. Otherwise, the software addresses all the available
serial ports, one after another, attempting to establish connection to the device which has the
corresponding serial number.
In the Serial number field, the user can enter the serial number of the device to link the
specific analyser to the specific position on the Device Manager panel. If the serial number is
unknown, leave this field blank, a serial number of the first free device of this type will be populated
after the establishment of a connection with the device.
Press Switch on on the right side of the Device configuration window to establish a
connection with an analyser. If the connection has been successfully established, you will see the
green On value in the Status field, but if there is no connection, the program will show a message
about failure to establish a connection.
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2.4.2 Tract configuration window
When you press
on the toolbar or select Tract configuration in the context menu of the
Channels column on the Tract Manager panel, a window shown on Figure 12 will appear on the
display.

Figure 12. Tract configuration window view
In this window, in the Tract name field the user may give the current tract a name, which will
be displayed in the Channels column on the Device Manager panel.
The Tract name field is intended for selecting the type of the detector (gamma, beta or alpha).
In the Channels field, specify the number of channels in the spectrum. Options in the
dropdown list of this field depend on the type of the analyser.
Field Set High Voltage is intended for specifying the value of high voltage, which should be
set for this type of detector. To actually set high voltage, press
, or press
to
remove it.
Depending on the analyzer’s type, this parameters group may have some additional fields such
as, for example, the following:
- HV polarity sets the polarity of the high voltage unit of analyser BOSON;
- Threshold which displays the amplitude discriminator value in arbitrary units. This value
may vary from analyzer to analyzer, this is why it should be set in accordance with a
spectrometer’s or analyzer’s documentation.
- Gain correction factor which displays the control voltage factor indicating by which value
the amplification coefficient should be changed to shift a peak’s position by one channel.
This parameter is needed for a correct functioning of the reference peak stabilization
system or auto adjustment of the spectrometry tract.
You can access specific parameters of the analyser by pressing
. It opens a
window, which can look differently depending on the analyser type.
If the analyser of this tract is inactive, buttons in the Tract configuration window will be
greyed out.
2.4.3 Measurement parameters window
When you press
on the toolbar or select Measurement parameters in the context menu
of the Channels column on the Tract Manager panel, a window shown on Figure 13 will appear on
the display.

12

Figure 13. Measurement parameters window view
This window contains parameters related to the measurement procedure:
File name – spectrum file name, which will be generated during the forthcoming
measurement on this spectrometric tract. The file name should be specified in full format with a path
to the location, where the file will be located. To get to the standard file selection dialogue window,
, which will appear on the right side of the field.
click in the field and press
Spectrum type – spectrum format selection window. The *.asw format is the standard
default type of spectrum for ASW2.
Preset time – exposition of the forthcoming measurement for this tract. The time unit for the
Preset time value is specified in the Unit field.
Reading interval – spectrum reading and displaying interval, sec.
The Sample data section contains parameters related to the sample being measured. These
data will be further displayed in parameters of the measured spectrum.
Sample ID – the identification number of the countable sample (text field).
Weight, Unit – mass and mass unit of the countable sample.
Volume, Unit – volume and volume unit of the countable sample.
Distance, mm - distance between the measuring sample and the detector. Allows recalculate
the registration efficiency at the present distance. For the correct account the efficiency file (*.efp)
should have efficiency curves for minimum two distances till the detector.
Geometry stands for the measurement geometry which should comply with the name
specified in the efficiency file (*.efp) when calculating activity by the peak analysis method. In this
field, one can select one of the geometries from the dropdown list. These geometries are in the
efficiency file loaded for the tract.
Material – name of the material being measured. It is selected from the list of materials, for
which there are data on the permissible content range. To select a material, click in the field and
13

press
, which will appear on the right side of the field. Confirm selection of the necessary
materials by pressing Apply (see section 4.3).
Comment – field for a comment about the forthcoming measurement (2 text rows).
The Coefficient of concentration section contains parameters related to the method of
preparation of the sample to be measured. These data will be further displayed also in parameters of
the measured spectrum.
Coefficient – value of the coefficient of concentration, rel. units. To get help in determining
the coefficient of concentration (including cases of radiochemical concentration), the user may open
an additional window, where this coefficient will be calculated. To open the additional window,
click in the field and press
, which will appear on the right side of the field (see Fig.14).
Use – field for enabling or disabling the use of the coefficient of concentration in further
calculations.

Figure 14. Coefficient of concentration window view
The Retry of measurements section contains parameters allowing to specify and set retry of
measurements in the automatic mode.
On – field to enable the retry of measurements mode.
Template files – file name template.
Iterations – the number of measurements to be conducted.
Pause, sec – field for setting the time between measurements, sec.
Directory of spectrum – the path, where any measured spectra will be saved.
The spectra file names are generated from the specified directory (Directory of spectrum)
and from the template of field specified in the Template files field, plus iteration number and
resolution.
Example of the first, second, etc. spectrum for the situation on Fig.13:
C:\ASW2\spe-g\temp_1.asw
C:\ASW2\spe-g\temp _2.asw
…
C:\ASW2\spe-g\temp_10.asw
2.4.4 Calculation parameters window
When you press
on the toolbar or select Calculation parameters in the context menu of
the Channels column on the Tract Manager panel, a window shown in Figure 15 will appear on
the display. This window contains the parameters which will be the spectrum parameters when the
spectrum has been acquired.
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Figure 15. Calculation parameters window view
This window contains parameters related to the calculation procedure:
Calculation type – the type of calculation, which determines, which unit will be displayed in
the resulting data table (specific activity, volume activity, etc.). Where,
'Specific activity, Bq/kg' means that during the calculation in addition to the activity the
specific activity in Bq/kg will also be calculated;
'Specific activity, Bq/g' means that during the calculation in addition to the activity the
specific activity in Bq/g will also be calculated;
'Volumetric activity, Bq/l' means that during the calculation in addition to the activity the
volumetric activity in Bq/l will also be calculated;
'Volumetric activity, Bq/ml' means that during the calculation in addition to the activity
the volumetric activity in Bq/ml will also be calculated;
'RFD, mBq/s·m2' means that the radon flux density will be calculated in mBq/s·m2 (see
document Methodology of radon flux density measurement);
'Volumetric activity of Rn-222, Bq/m^3' means that the volumetric activity of radon
will be calculated in Bq/m3 (see document Methodology of radon volumetric activity measurement);
'Content' means that the radionuclide content will be calculated in the units of
measurement specified by user (this is applicable in the window method, see Section 14).
Activity unit - sets the radioactivity unit (Bq or Ci).
Background spectrum is the path to the background spectrum for this spectrometric tract. A
link to this field will be shown in parameters of the measured spectrum.
Calibration file (ROI-method) – path to the calibration file, which will be used for
calculation of activity using the ROI-method.
Calibration ADER – path to file of calibration by ambient dose equivalent rate, which will
be used automatically, when reading the spectrum and displaying it.
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List of calibration spectra (superposition method) – path to the file list of calibration
(reference) spectra, which will be used when calculating the activity by the superposition method.
Zone file – path to the file (*.roi), which contains windows of regions of interest.
Section Error contains parameters L and Combined st.uncertainty (type B) Q . The latter
parameter is the total relative standard uncertainty of measurement of type B expressed as a decimal
quantity. The both parameters are considered in calculation of uncertainty of radioactivity (see the
"Description of Algorithms Implemented"). Parameter Q can be readily calculated provided that the
uncertainty budget (that is, the standard uncertainty values of the measurement components) is
known. To this end, specify these values in the corresponding subfields of parameter Q:
St. uncertainty of mass stands for the standard uncertainty of a sample’s mass;
St. uncertainty of volume stands for the standard uncertainty of a sample’s volume;
St. uncertainty of sensitivity stands for the standard uncertainty of the sensitivity
coefficients;
St. uncertainty of method stands for the standard uncertainty of the method applied;
St. uncertainty Q1 stands for the standard uncertainty defined by user;
St. uncertainty Q2 stands for the standard uncertainty defined by user.
Note that the two latter fields can be used for the components specified by the user in
accordance with the measurement method applied. This, for example, could be the uncertainty of the
distance from the source.
The Reference date section contains parameters allowing to set the date of activity in the
measurement results.
On measurement date – when the value in this field is enabled, activity will be calculated
as at the measurement date, otherwise the date will be taken from the Date and Time field.
The Directories section contains paths to Calibration files, Working spectra and
Background spectra. These directories will open by default, when standard file selection dialogue
windows open.
The Search peaks section contains parameters participating in the search of peaks in the
spectrum and their displaying.
L.limit, R.limit are the boundary channels of the range where the search of peaks will be
performed.
Level is the extreme value of the parameter related to the statistical significance of peaks. If
this value is exceeded, a peak is accepted and added to the table; otherwise, the peak is rejected. The
value of parameter Level can vary within the range from 0.5 (all the peaks, even those close to
fluctuation peaks, are accepted) to 5 (only the most prominent peaks featuring significant difference
from statistical fluctuations are accepted). The optimum value of this dimensionless quantity is 3.
Min.area – the limit value of the peak area in impulses. The peaks with the value above this
one are accepted and added to the table, and below this value are rejected.
Type search – one of two possible types of search for peaks in the spectrum ('Search and
Identification', 'Peaks from library'). So, the 'Search and Identification' type searches for all the
peaks available in the spectrum and meeting the criteria of the Search peaks section. The 'Peaks
from library' type envisages application of preliminary markings according to the loaded
radionuclides library file (see the Library file field in the Identification section).
Background base type sets either linear or step background base for peak processing.
Show peaks – parameter for enabling displaying of peaks and their parameters in the
spectrum.
Update peak when reading – the parameter showing the need to update peak markings in
the process of measurement, when the spectrum is constantly changing. If a peak is added in the
process of measurement, it is recommended to enable this parameter, otherwise there will be a visual
discrepancy between real peaks and marked peaks.
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The Smoothing parameters control polynomial smoothing of a spectrum relevant for a
better peak search and description of peaks by functions. The Smoothing parameters include:
Polynomial degree. This parameter defines the degree of the polynomial smoothing to be
considered for spectrum peak search. The parameter’s value should not exceed 6, and the
recommended value is 5.
Iteration. This parameter defines the number of smoothing iterations for spectrum peak
search. If this value is 0, no smoothing will be performed. Spectra featuring high statistics should
not be smoothed, and the parameter’s value for such spectra should remain 0.
The Identification section contains parameters participating in the identification of the peaks
found in the spectrum.
Library file – path to the radionuclides library file, which will correspond to the measured
spectrum. The library file contains a list of radionuclides, their energy values, probability of outputs
and half-lives. Library files are generated using the Library editor dialogue (see section 12) and are
used in the process of calculation of activity using the peaks analysis method.
Efficiency file – path to the efficiency calibration file, which will correspond to the
measured spectrum. The efficiency calibration file contains a dependence of the efficiency of
registration on gamma-quantum energy and is used in the process of calculation of activity using the
peaks analysis method. The efficiency file is generated using the Efficiency calibration dialogue
(see section 9).
Factor peak thickness, ch - is the peak thickness factor, or, in other words, the distance at
which two peaks are indistinguishable. The value of this parameter is set in arbitrary units in the
range between 3 and 10. In case two peaks close to each other are processed separately as if they
were singlets (i.e, each peak has its own background substrate) but they are supposed to be
processed together (I,e., so that they have a common background substrate), the calculation should
consider this parameter and be repeated until the peaks are processed together as a multiplet.
Allowable dev., keV – the energy deviation parameter, within which a peak may be assigned
to a characteristic curve of some radionuclide.
2.4.5 Spectrum view parameters window
When you press
on the toolbar or select Spectrum view parameters in the context
menu of the Channels column on the Tract Manager panel, a window shown on Figure 16 will
appear on the display.

Figure 16. Spectrum view parameters window view
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This window contains parameters describing the appearance of spectra for this spectrometric
tract such as background colour, histogram of the spectrum, grid, axes and marker. When the
Default colors parameters is enabled, colours will have their default values.
Subsection Zones colors sets colours of the zones of interest in a spectrum. This setting
concerns the colours of both selected and the other zones. Note that the colours can also be chosen
by gradient setting.
Fields Show Tab 'ROI-method' and Show Tab 'peaks analysis' enable or disable the tools
related to the corresponding spectrum processing type (ROI-method or peak analysis method).

3 Measuring and saving a spectrum
For the purposes of measurements, the user must first select an analyser and a spectrometric
tract to work with. To do this, left click on the respective tract in the Device Manager. To perform a
measurement, make sure that the selected analyser is connected and a connection with it has been
established (see section 2.4.1).
It should be noted that the analysers connected via the USB interface (BOSON, MCA527, Polynom, etc.) require installation of drivers, which should be installed in addition, after
the program has been installed. When you have connected your device to the PC (by
connecting a USB cable and switching it on), Windows will discover a new device in the system
and will offer to install a driver, which is located in the relevant directory of the program (by
name of the device). Specify this path and then Windows will install the analyser.
Before starting measurements, set the time of measurement. This can be done in the
Measurement parameters window (see section 2.4.3). In this window, you can also set the file
name, if needed. Other parameters are also set in the Measurement parameters window and in the
Calculation parameters window, when needed (see section 2.4.4).
When the analyser is ready, control buttons (Start, Stop, Read and Clear) on the main
toolbar will be clickable and coloured in, otherwise, all the buttons will be greyed out and inactive.
To start a measurement, press
, then a window of the spectrum to be measured will
appear (Fig. 17), which will show a histogram.
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Figure 17. Window of the spectrum to be measured
The window of the spectrum to be measured differs from the spectrum, which is opened, by
presence of redundant buttons allowing to control the measurement on the toolbar (see Fig.18).

Figure 18. Group of buttons for control of a spectrometer on the toolbar of the window of the
spectrum to be measured
The spectrum to be measured has a connection indicator
on the toolbar, showing the
event of program’s contact with the analyser (the indicator gets red, when they exchange data).
After the start, the window with the spectrum is updated with the interval specified in the
Measurement parameters window (see section 2.4.3).

During a measurement, the Device Manager panel will display a countdown timer as shown
on Figure 10. When a measurement ends, a message shown on Figure 19 will appear on the display.

Figure 19
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The message is asking whether you want to save the spectrum to a disk. If the spectrum was
previously named, then the spectrum will be saved automatically, but if no name was assigned to the
spectrum, the program will offer to enter a new file name and specify its saving location.
To force-stop writing a spectrum in the process of measurement, press
. The message
shown on Figure 19 will appear on the display again.
If the user closes the spectrum window after a measurement, it can be restored by pressing
on the main toolbar of the program.
If the user needs to enter or edit parameters of the measured spectrum after the measurement
has ended, this should be done in the Spectrum parameters window (see Fig. 20), which can be
on the toolbar of the spectrum window. Changes in parameters of any
opened by pressing
reopened spectrum are made in the same way.

Figure 20. Spectrum parameters window view
Window Spectrum parameters can be pinned to the frame of the spectrum. To do this,
double click on the window heading, then a window will move to the right side of the spectrum
window.
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4 Work with a spectrum
4.1 Main functions
To open a spectrum, click menu item File->Open spectrum, alternatively, click button
in the toolbar of the program’s main window. The standard *.asw file format will be suggested by
default. However, the software is able to open and edit files of other types. To change the type of a
spectrum loaded, select the desired file type in the dropdown list of field Files of type in the
standard dialogue window (see Fig. 20.1).

Figure 20.1 Choosing a spectrum type in the standard loading window
Once a spectrum (spectra) is selected, the software displays spectrum window(s) as shown in
Fig. 21. Now, the spectrum (spectra) can be processed.
Work with a spectrum may include different tasks, for example, studying the obtained
energy distribution, spectrum zooming, processing of individual peaks, printing of a spectrum,
energy calibration and so on.

Toolbar
Marker

Current
selected
peak

Peak
label
Status
bars

Figure 21. Spectrum window view
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Figure 21 displays main elements of the spectrum window.
The first (upper) status bar displays live, real time values in seconds for this spectrum, as
well as dead time in percent.
The Intens. field of the status bar displays the aggregate value of intensity across the
spectrum, i.e. the integral value of the entire spectrum divided by live time.
If a calibration ADER (ambient dose equivalent rate) file has been uploaded, the last field of
the upper status bar will display the ADER value.
The second (lower) status bar displays values of the marker position in channels and energy
units. Field Counts displays the count value in the spectrum corresponding to this channel.
The main spectrum working mode, when the mouse cursor looks standard (white arrow),
provides the possibility to zoom the spectrum and to drag (move) it on both axes. To zoom a
spectrum region (i.e. stretch), set a marker in the left position of the region, press and hold the left
mouse button moving it all the way to the right. In the process of dragging, a grey transparent
rectangle showing the boundaries of the selected region will appear. A block of information with
data of the range boundaries, area and intensity in this range will appear near the region selection.
When selected, release the mouse button, and the spectrum will be stretched to the width of the
selected region. To return to the previous zoom level, press
on the spectrum toolbar. To return
to the initial zoom level (to the full range of the spectrum), double click anywhere in the spectrum.
If you need to move the spectrum left or right along the horizontal axis, press the right
mouse button and hold it while moving the cursor in the desired direction. The spectrum will move.
The spectrum toolbar contains the following buttons:
- button for displaying spectrum parameters as shown on Figure 20.
- button for saving spectrum data and parameters to a disk. When you press this button,
any discovered peaks and their parameters are also saved to a disk. These data are stored in the file
with the same name as that of the spectrum, but have an *.asr extension, and the location of this file
is the same as that of the spectrum.
To the right of this button, there is an arrow. Clicking the arrow opens menu with the
following options:
Save saves a spectrum preserving its current name;
Save as… saves a spectrum with a new name specified in a standard dialog box for file
saving;
Save spectrum without background saves the current spectrum without the background: a
new spectrum appears on the screen and gets saved on disc. The name of this file additionally
contains '_wb'. For example, if the name of the original file is c:\asw2\spe_g\test.asw, then
the
name of the spectrum without background is c:\asw2\spe_g\test_wb.asw
- button for opening the energy calibration window for this spectrum (see section 7).
- button for opening the FWHM and shape calibration window for this spectrum (see
section 8).
- button for enabling the mode for work with a peak. Thanks to this mode, the user has
the possibility to study any peak or multiplet in detail, as well as adjust the peak with describing
functions. When you press this button, it gets fixed and the cursor moving around the spectrum field
looks like two closed brackets '[]'.
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To select a spectrum region, which will be moved to a separate window for work with the
peak, set a marker to the left position of region, press and hold the left mouse button moving it all
the way to the right (Fig.22). In the process of dragging, a dark transparent rectangle showing the
boundaries of the selected region will appear. Then release the mouse button and an additional
window with the selected region will appear on the display (see Fig.23).

Figure 22

Figure 23. Window for work with a peak view
23

Additional peak processing options are described in section 4.2.
- this button opens the measurement results panel.
- button displaying a menu with spectrum options. When you press this button, a menu
shown on Figure 24 will appear.

Figure 24. Menu Options of the spectrum window
Items in this menu are mainly intended for service and have the following functions:
Results – opens a panel of measurement results.
Add to log – sends measurement results to a log.
Send to pack – opens this spectrum in the Pack of spectra window.
Panorama window - when opened, this window (see Fig. 24.1) displays that part of a
spectrum which is marked by scaling in the main spectrum window. The semi-transparent rectangle
can be moved by user which automatically changes the scaling in the main spectrum window. The
opposite is also true: changing the scale and zooming the spectrum’s regions is automatically
displayed in the Panorama window.
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Figure 24.1. The Panorama window of a spectrum.
Logarithm – enables a logarithmic scale for spectrum display.
Show background – shows the background spectrum.
Hide spectrum – hides the spectrum.
Spectrum without bkg – shows the spectrum without spectrum background.
Intensity – switches the vertical axis from the count in impulses to intensity in imp/sec.
Energy range – switches the horizontal axis from the channel scale to the energy scale.
Show ROI – shows regions of interest (ROI) contained in the calibration file (*.clb) for the
ROI-method.
Offer a nuclide – a tool aiding in identification of radionuclides, which highlights regions of
the spectrum, where peaks for the radionuclide selected from the list should be present (see section
4.4).
Report suggests two options:
Report – generates a protocol for printing the spectrum.
Add to current report - adds a current spectrum histogram to the so called „current”
report that enables creation of a protocol containing any kind of data (table, text, image) in any
sequence.
Autocalibration by source (Cs-137, Co-60, Eu-152, Th-228) – a tool allowing to perform
automatic calibration by energy, FWHM and shape of a spectrum with radionuclides most used in
spectrometry. The procedure may last several seconds. At the end of autocalibration, the
programme will display a message with the results and enter the received values in the spectrum
calibration.
Send to (Word, Excel, Matlab, Save picture) sends the spectrum to MS Word, MS Excel
or Matlab, respectively, or saves it as a *.jpg image.
opens the current report’s window for overview, editing and printing. More information
on the current report can be found in section 4.5.
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enables the zones of interest mode. When the button is clicked, it gets locked, and the
cursor changes its appearance to . The user can now choose zones of the spectrum by clicking and
holding the left mouse button. When a zone of interest is selected, it is automatically sent to the
table in tab Zones in the bottom measurement results panel (see Fig. 35.1 in section 5.5).
The
group of buttons is intended for searching peaks, as well as
calculating activities using the peaks analysis method (see section 6).
is a separate button which control the functions related to activity calculation by the
ROI-method that is thoroughly described in section 5.
4.2 Work with a peak
In the peak mode, a window as shown on Figure 23 appears on the display after selecting a
spectrum region.
This window has a toolbar with buttons allowing to perform mathematical modelling for the
purposes of describing peaks by dependencies, or, in other words, to introduce Gaussian curves (or
other functions) in the selected spectrum region.
The
(Gaussian) button is intended for introduction of the Gaussian curve in the region
of the Peak window. The program determines automatically the centroid of the peak and calculates
all the parameters related to this peak. Peak processing results are displayed in a window as shown
on Fig. 25.

Figure 25. View of the Peak list window with peak processing results
The bottom string in Fig. 25 contains two buttons which send the data on the peak to energy
calibration (button Energy) and FWHM and peak shape calibration (button FWHM and Shape).
Button Multiplet with high resolution
provides Gaussian approximation for a multiplet
(up to three merging peaks) in window Peak. To perform this, the user should set a marker (close)
to the centroid channel of each assumed peak. A marker is set by double clicking the left mouse
button in the vicinity of a peak centroid. When all the markers are set, click button
to perform
calculation. The result of it will be shown in the window similar to that shown in Fig. 25. Should the
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approximation curve be wrong, the user has to cancel the markers and the curve by button
and
reset the markers.
Each peak is approximated by a function which consists of a Gaussian and a so called
exponential left edge. Parameter 'Left edge' stands for the distance (in channels) between a peak’s
centroid and the starting point of the left edge (see Fig. 25).
Additional clicking button

might even improve approximation of the peaks by the model

curve.
Button
Add peaks to peak list of spectrum on the toolbar in the Peak window is
intended for adding processed peaks to the spectrum results table. If the peak’s area is smaller than
the threshold area (specified in the Min. area parameter), then the peak addition command will be
ignored.

Figure 26. Window Peak
The context menu, which pops up, when you right click on the graph in the Peak window,
has the same buttons as the toolbar, and also:
Energy range – switching between channel and energy scale;
Logarithm – switching between linear and logarithmic scale;
To printer – printing of the graph in the Peak window.

4.3 Material window
The Material field in the Spectrum parameters window is intended for specifying the type
of substance to be measured or its category for the program. When you press
at the edge of the
field, a window opens (see Fig. 27), which allows managing the files containing information about
values of Permission Level (PL). The file with the data on PL has a *.mat extension.
buttons on the toolbar of the Material window allow editing the table of
materials (to add/delete a material or a radionuclide).
or loading a table saved to a disk.

buttons are for saving the edited table
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Figure 27. Material window
4.4 Prompt window
Using the Offer a nuclide command in the Options menu (see section 4.1, Fig.24) in the
measured spectrum with distinct peaks, you can visually identify nuclides from the set library of
nuclides librp.dat. When you activate the Offer a nuclide menu item, a Prompt window, which
will display the list of radionuclides, will appear on the display (see Fig.28).

Figure 28
To select items, press on the row with the name of the expected radionuclide with a mouse
button. Areas in the spectrum in the region of lines of the respective nuclide are highlighted in
white, and are marked with the value of quantum yield for this line.
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4.5 Current report
Current report conception enables receiving and creation of any kind of spectrum data in
arbitrary sequence. For example, a protocol containing a table with activity values calculated and a
spectrum image can be readily generated by clicking button Add tables of results to current
report located above the results table (see Fig. 30) and then clicking button Add to current report
in the spectrum menu (see Fig. 24). After this, the current spectrum window will appear as shown in
Fig. 28.1:

Figure 28.1
The protocol generated can be immedeately printed by clicking button
.
The objects exported to the protocol are listed to the left, in window Current report. This
sequence can be saved as a template by clicking button

in the toolbar above the list. In order to

generate a protocol with similar data sequence, click button

in the toolbar of the spectrum

window to open window Current report and then click button
(Generate current report by
template).
Additionally, the list of the protocol’s objects can be deleted or cleaned by clicking button
or
, respectively. The data objects in the protocol can be edited or deleted as it is done in a
standard text editor.
The data sent to window get not deleted, so that filling the protocol can be resumed after the
window is reopened by clicking button

in the spectrum window.

5 Determining activities of radionuclides by the ROI-method
5.1 Calculation by one spectrum
To calculate (specific/volumetric) activity of radonuclides, do the following:
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Load a working spectrum (File->Open spectrum).
Open the spectrum parameter window by pressing .
Load a spectrum background in the Background field and the necessary calibration file
(*.clb) in the Calibration field.
Then, press the right part of the
calculation types (see Fig.29).

button to open a menu offering variants of

Figure 29. Variants of calculation types
For this task (calculation of activity by one spectrum using the ROI-method) select
Calculation (ROI-method)
Toolbar of the
results table

Figure 30. Calculation results window view
A table with measurement results will appear at the bottom of the spectrum window or in a
separate window. This table contains columns for 'Nuclide', 'Activity’, relative accidental error of
spectrum shape selection 'Ac.error,%', as well as columns for specific activity, absolute and
relative errors in their determination. If the Material field (in the spectrum parameters window)
contains instructions about the type of substance to be measured, two more columns PL (permission
level) and FC (factor of conformity) will appear in the results table.
It should be noted that the 'Activity' column contains values corresponding to the
counting sample, but 'Sp.activity' (column 4) – those corresponding to the material of sample.
Thus, the coefficient of concentration is taken into account, when calculating specific activity
(and so on in column 4).
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If relative error in the calculation of activity exceeds 50%, then the MDA (minimum detected
activity) value is displayed in the 'Activity' field instead of the activity value.
The panel with calculation results should not necessarily be within the spectrum window. It
can be 'separated' from the left edge of the spectrum by double clicking on the heading of the
Calculation results panel, or you can drag the panel holding its heading. To return the panel to the
spectrum window, double click on the heading of the Calculation results window with the left
mouse button.
Specific activity value Aeff of the natural radionuclides and total conformity factor are shown
in the additional field below the table.
Click button
above the results table to open a window which displays additional data
related to the calculation performed (see Fig. 30.1):

Figure 30.1. Additional data window
The additional data window displays the names of the calibration files applied, background
spectrum and working spectrum, activity reference date, mass and volume of the count sample and
concentration coefficient (if the latter was taken into account).
The toolbar above the results table contains buttons to save the data in the table in various
ways. Namely, button
saves the data as a .txt text file; button
sends the data to MS word;
button
generates report; button sends the data to a database.
To save the data in the text protocol, the name of the file should be specified in field
Protocol filename in window Parameters (main menu Options->Parameters->tab Files). The
data will be appended to the text file specified.
To be able to send data to MS Word, MS Word should be installed in your Windows
operating system.
When a report is generated (
button), a window is displayed, where the preview block
displays the table of activities and the block of comments (see Fig.31). You can add title information
to the page. This option requires a printer installed in the Windows operating system.
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Block 1

Figure 31a
Figure 31. Report generation window view
After changes have been made (title editing, disabling/enabling fields), press Update. There
is a Print button for printing the page shown in the right part of the window (the so-called preview
block). To send the page to MS Word, press
. To save the page in the *.rtf format, press Save.
Pressing the button
in instruments panel of results table will cause the window Database
of measurements (see.p.6.6 and Fig.41.1) and additional window for data input, which are not
saved in spectrum (Fig.32).

When the fields are filled with the data, the button Add should be pressed. At successful
transfer the corresponding message will appear.

Figure 32. Window Add to database
5.2 Common calculation by sample number
According to the requirements of regulatory documents, the results of measurements of
specific activities received in different spectrometric tracts, as well as the consolidated factor of
conformity of the sample being measured, should be shown in a single protocol of measurement. To
fulfil this requirement, use Common calculation in the menu of the
Fig.29).

Calculation button (see
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For a correct calculation:
- open spectra of one sample measured in different spectrometric tracts (for example, on a
beta and gamma detector);
- make sure that the Sample ID field (see Spectrum parameters window) displays the same
identifier for all the spectra;
- conduct a separate calculation for each spectrum (see section 5.1);
- for one of the spectra you can select Common calculation in the menu of the
Calculation button.
When you have received the results table, make sure that there is a note about the common
calculation (Fig.33), as well as confirm adequacy of the received results.
If there is specific activity calculated in different spectra, its result is averaged taking into
account the calculated error.
If there is specific activity calculated in one spectrum (error less than 50%), and only
assessments (equal to MDA) in the other spectrum, only the data containing specific activity are
used in averaging.
If assessments only (equal to MDA) are available in all the spectra, the smallest of these
assessments is displayed as the result for this radionuclide.

Note about
common
calculation

Figure 33. View of the table of the result of common calculation by sample number
5.3 Combined beta – gamma calculation
In cases, when sample measurement is made on a gamma and beta detector, in order to
increase accuracy, it is sometimes necessary to consider the results determined in one of
spectrometric tracts in calculations of the other one. Thus, for example, when performing
measurements in a beta tract taking into account activity 137Cs and 40К in the gamma tract, minimum
detected activity 90Sr can be reduced.
For a correct share beta-gamma calculation:
- open spectra of one sample measured in different spectrometric tracts (on a beta and
gamma detector);
- make sure that the Sample ID field (see Spectrum parameters window) displays the same
identifier for both spectra;
- conduct a separate calculation for the gamma spectrum (see section 5.1);
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- for the spectrum of the beta detector you can select Combined calculation BG in the menu
of the

Calculation button.
When you have received the results table, make sure that there is a notification about the
combined beta-gamma calculation (Fig. 34), as well as confirm correctness of the results obtained.

Note about the
combined
beta-gamma
calculation

Figure 34. View of the table of the result of a combined beta-gamma calculation

5.4 Superposition method
The calculation of activity using the superposition method serves as some kind of control of
measurements. After a countable sample has been measured and the calculation has been conducted,
the accuracy of calculation of activities may be controlled in the Superposition window by
selecting the Calculation by superposition method in the menu of the

Calculation button.

Block 1

Block

Block 2
Figure 35. Superposition window view
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If the calculation has already been performed, the program displays (Fig,35, block 1) the
measured (red) and the estimated (green) spectrum, as well as estimated values of activities of
radionuclides (Fig.35, block 2). If the measured and the estimated spectra match, this confirms that
the list of radionuclides and their activities match the radionuclide activity of the countable sample.
Through visual evaluation of matching of spectra the user may adjust estimated values until
the spectra fully match. If full match is still impossible, it may be assumed that the countable sample
contains other radionuclides in the countable sample or there is inaccuracy in energy graduation.
The
button is used for selection of a library spectra list file (*.lcs), which is necessary
for the calculations. This file is generated at the calibration stage for each measurement geometry
(see Paragraph14.2) and is supplied in the installation package of the spectrometer.
The
button is intended for updating the calculation after uploading a new library spectra
list file.
The Log checkbox shown on Fig.35 (block 3) provides the possibility to change the scale of
the graph of spectra to logarithmic. The Bkg checkbox brings the current background spectrum to
the graph. The R/n checkbox allows displaying on the graph spectra of mononuclides participating
in plotting of the common spectrum (green).
The status bar of the Superposition window displays information about the currently loaded
library spectra list file, the number of these spectra and the number of radionuclides.
5.5 Regions of Interests
Typical task for spectrometry is the work with regions of interest (ROI, zones) in a spectrum.
Regions of interest are intervals in a spectrum (in channels or energy units), where intencity of count
rate is important for the activity evaluation or solution of other radiometrical tasks.
For operation with ROI the operator should open the field Caclulation result in a spectrum by
pressing the button
in the instruments panel of spectrum window. Then go to the Tab Zones in the
appeared window (see Fig.35.1)
Block 2

Block 1

Figure 35.1. View of the spectrum and Tab Zones
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To add ROI to the table the button
should be pressed over the table.
After the pressing, the first line, filled with values on default, will appear. The fields in the
columns L.border,ch, R.border,ch, L.border,keV, R.border,keV are available for editing. The user
could change the boarders of each zone himself directly in the table, the corresponding fields in linked
columns will change in accordance to the energy calibration (see Fig.35.2).

Figure 35.2. Tab Zones view. ROI set up in the table
Zones’ boundaries can also be adjusted in a spectrum window. To this end, set the cursor to the
either boundary of a zone, click and hold the left mouse button and shift the boundary to the left or right.
The boundary value for the zone in question will change automatically in the table.
The transparent background of a zone selected in the table (the active zone) can be different from
the other zones of ineterest. These colours are set in window Spectrum view parameters (see section
2.4.5).
in the
To add a zone to the table, one can also activate a special mode by clicking button
toolbar of the spectrum window (see Fig. 35.1, block 2). When the button is clicked, it gets locked, and
the cursor changes its appearance to . The user can now choose zones in the spectrum by clicking and
holding the left mouse button. When a zone of interest is selected, it is automatically sent to the table.
The fields of the columns Total, pulse, Intensity, cps, Intensity without background,cps are
not acceptable for the alteration by the user, the calculated values are displayed there by the program.
For ex.: the fields of the column Total, pulse have sum qualnity of the pulses in the interval, specified
for the present line. The fields of the column Intensity,cps have the pulses count rate in the interval,
specified for the present line. And in the fields of the column Intensity without background,cps there
are the count rate values after deduction of background spectrum count rate for the same energy range.
To delete the lines in the table (delete ROI) they should be marked and the button
in the instruments panel over the table should be pressed. To clear the table the button
pressed.

should be

To save the current table in zones file (*.roi) the button
should be pressed. If zones file for the
present spectrum has not been specified, the program will offer to enter the name and indicate the
catalogue for recording via a standard dialogue window. Then zones file will be automatically
connected to the present spectrum and will be assigned into the field Zone file in the window
Spectrum parameters (see. Fig.20). In case there is already a link between zones file to the spectrum,
the program will offer to rewrite it with a new content.
The user could access the record function for ROI table into the report. Then it is necessary to
press the button

over the table, then the window will appear as shown in Fig 35.2.
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Figure 35.3. Report window by ROI
The content of the report is available to print out and copy into other text editors and electronic
tables.

button

The data in the table for zones of interest can also be sent to the current report by clicking
above the table. This opens the current report window.

6 Determining activities of radionuclides by the individual peaks analysis
method
6.1 General statements
The principle of determining activities of radionuclides using the individual peaks analysis
method is the possibility to search for peaks automatically, describe each of them using the Gaussian
curve (with protracted left exponential edge), further calculate the area and, finally, calculate
activities by each identified radionuclide. The ability to identify is conditioned by the possibility to
connect to the spectrum a radionuclides library file, which contains reference data on characteristic
energy lines, values of their quantum yield, etc. So, if there is a spectrum of a countable sample, a
library file (*.lbr,*.bib) and an efficiency file (*.efp), the user may calculate activities of
radionuclides.
For the method to work accurately, the user must fill in fields in the Spectrum parameters
window with relevant values. Main parameters determining the work of the method being described
are concentrated in the right table of parameters (see Fig. 36) in Search Peaks, Smoothing,
Identification groups.
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Main parameters
for the
calculation using
the individual
peaks analysis
method

Figure 36
The Search peaks group contains the following parameters:
L.limit, R.limit – range values in channels, where the search of peaks will be performed.
Peaks will not be searched for and identified outside this range.
Level – the limit value of the parameter related to the statistical importance of peaks, above
which the found peak is accepted and added to the table, and below which the peak is rejected,
usually assumed as being equal to 3.
Min.area – the limit value of the peak area in impulses. The peaks with the value above this
one are accepted and added to the table, and below this value are rejected.
Background base type - sets the type of the background base for peak processing to be
chosen between the linear and the step type.
Search type – one of two possible types of search for peaks in the spectrum ('Search and
Identification', 'Peaks from library'). So, the 'Search and Identification' type searches for all the
peaks available in the spectrum and meeting the criteria of the Search peaks section. The 'Peaks
from library' type envisages application of preliminary markings according to the loaded
radionuclides library file (see the Library file field in the Identification section). If the user faces
the task of determining the activity of certain radionuclides only, 'Peaks from library' should be
used.
Show peaks – parameter for enabling displaying of peaks and their parameters in the
spectrum.
The Smoothing parameters control polynomial smoothing of a spectrum relevant for a
better peak search and description of peaks by functions. The Smoothing parameters include:
Polynomial degree - this parameter defines the degree of the polynomial smoothing to be
considered for spectrum peak search. The parameter’s value should not exceed 6, and the
recommended value is 5.
Iteration - this parameter defines the number of smoothing iterations for spectrum peak
search. If this value is 0, no smoothing will be performed. Spectra featuring high statistics should
not be smoothed, and the parameter’s value for such spectra should remain 0.
The Identification group contains parameters participating in the identification of the peaks
found in the spectrum.
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Library file – path to the radionuclides library file, which will correspond to the measured
spectrum. The library file contains a list of radionuclides, their energy values, probability of outputs
and half-lives. Library files are generated using the Library editor dialogue window (see section
12) and are used in the process of calculation of the activity using the peaks analysis method.
Efficiency file – path to the efficiency calibration file, which will correspond to the
measured spectrum. The efficiency calibration file contains a dependence of the efficiency of
registration on gamma-quantum energy and is used in the process of calculation of activity using the
peaks analysis method. The efficiency file is generated using the Efficiency calibration dialogue
window (see section 9).
Passport of source – a link to the file containing parameters of the source of calibration. The
file must contain the list of radionuclides present in the source, description of their geometry, mass,
volume, activity and the date of its adjustment. The passport of source file is generated in the Editor
of source passports dialogue window, which can be opened from the main program menu Options>Editor of source passports. It should be noted that the passport of source file should be specified
only during calibration (i.e. to create the efficiency file). To perform calculations for the purposes of
determining activities, this field should be left blank.
Factor peak thickess, ch - this is the peak thickness factor, or, in other words, the distance
at which two peaks are indistinguishable. The value of this parameter is set in arbitrary units in the
range between 3 and 10. In case two peaks close to each other are processed separately as if they
were singlets (i.e, each peak has its own background substrate) but they are supposed to be
processed together (I,e., so that they have a common background substrate), the calculation should
consider this parameter and be repeated until the peaks are processed together as a multiplet.
Allowable dev., keV – the energy deviation parameter, within which a peak may be assigned
to a characteristic curve of some radionuclide
In the realisation of the individual peaks analysis method, calibration of the spectrometric
tract (or the spectrum) by peak energy, FWHM and shape becomes special. Therefore, before
performing the calculation, make sure that the respective calibrations have been made (see sections
7, 8).
6.2 Procedure of calculation of activities by the individual peaks analysis method
6.2.1 Measure the spectrum of the countable sample or load an available spectrum using the
main program menu File->Open spectrum.
6.2.2 Information about the source may be entered before, during and after the measurement.
In the first and second case, parameters are specified in the fields of Measurement parameters and
Calculation parameters windows.
6.2.3 If parameters of any measured spectrum need to be changed, the Spectrum
parameters window should be used (see Fig. 36)
6.2.4 Depending on the task, specify one of search types ('Search and Identification',
'Peaks from library') in the Type search field (Fig.36).
6.2.4 Among the fields of the Spectrum parameters window, which should be completed,
there is an Efficiency file field. You should enter the name of the calibration efficiency file there (
button). The operator selects the efficiency file according to the type of the countable sample and
parameters of geometry of measurement and enters it into the program using a standard file selection
dialogue window.
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6.2.5 In the Library file field in the Spectrum parameters window, specify the name of the
radionuclides library file, which contains data about energy lines and other information about
radionuclides, which are presumably contained in the sample being measured.
6.2.6 Then, select the Calculation by peak analysis method in the menu of the
Calculation button (see Fig.29). Then, a panel with results of measurements with the Peak analysis
tab selected will appear at the bottom of the window. As it was mentioned in p.5.1, the panel with
measurement results can be separated from the spectrum frame.
6.2.7. On the Library tab of the table, check those radionuclides, the activity of which the
user intends to determine. This tab displays data contained in the library file specified in the
spectrum parameters window (Library file field).

Figure 37. Library tab view

6.2.8 On the toolbar of the spectrum window (Fig.38, block 1), press
(New search peak
and calculation). If the spectrum has correct calibration by energy, FWHM and shape of the
spectrum, the Peak analysis tab of the measurement results panel will display information on any
discovered peaks (Fig.38, block 3). Also, found highlighted peaks with titles will appear on the
spectrum graph (see Fig.38, block 2).
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Block 2

Block 1

Block 5

Block 3

Block 4
Figure 38. Spectrum window view after peak search
The results panel, under the table with Found peaks, has another table Result by
radionuclides, which contains estimated values of activities of radionuclides.
The Found peaks table has the following fields:
'Number' – number in sequence of the found peak;
'Channel' – position of peak centroid in channels;
'Energy' – energy value, keV;
'Line' – characteristic energy lines of gamma radiation for the specified radionuclide;
'*' – indicates that additional library energies close to the peak energy in question are likely
to be in the spectrum;
'Peak area' – is the peak area, counts;
'Peak intensity' – is peak intensity, counts per second;
'Activity, Bq' – radionuclide activity value determined only for this line;
'Stand.uncert.,%' – standard relative uncertainty of activity calculation for this line;
'Gross area' – is the area of the peak itself and background base, counts;
'FWHM' – is the width of the peak at the half of its height, keV;
'FWTM' – is the width of the peak at 0.1 of its height, keV;
'Residual' – is the discrepancy parameter describing how well a peak is approximated;
'Decision threshold, Bq' – Decision threshold, Bq according to ISO11929;
'Detection limit, Bq' – Detection limit, Bq according to ISO11929;
'Best estimate, Bq' – Best estimate, Bq according to ISO11929;
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'Stand.uncert. of Best estimate,%' – is the standard uncertainty of the best estimate, %,
according to ISO11929;
'Benchmark' – sign of acceptance of this line as a benchmark. Used for the purposes of
improving splitting of merged multiplets into components.
The Result by radionuclides table contains the following fields (see Fig. 38, block 4):
Nuclide – name of the radionuclide, on which this row contains information;
Activity, Bq – weighted average activity in Bq received by averaging activities from the
Found peaks table considering the uncertainly for each line. If relative expanded uncertainly in the
calculation of activity exceeds 50%, then the MDA (minimum detected activity) value is displayed
in this field instead of the activity value.
Sp.activity, Bq/kg – specific activity in Bg/kg (parameter depending on the calculation
type);
Exp., uncert.% – expanded uncertainly of the result of measurement with coverage factor
k=2;
'MDA, Bq' – is the value of the minimum detectable activity, Bq;
'Decision threshold, Bq', 'Detection limit, Bq', 'Best estimate, Bq', 'Stand.uncert. of
Best estimate,%' - are the average values of the same-named parameters that are described above
for table Result by radionuclides.
The Result by radionuclides table, which is being described, may contain two columns PL
(permission level) and FC (factor of conformity), which were described in section 5.1.
In the Result by radionuclides table, for each radionuclide, for which activity has been
calculated, you can see lines, on which this activity was calculated. To do this, you should press on
the icon located in front of the name of the radionuclide.
6.2.9 Visually analyse adequacy of the plotted mathematical model for each found peak, i.e.
evaluate the quality and correctness of description of the Gaussian curve peak. If the peak
description is unsatisfactory, it should be deleted or adjusted (see section 19.1). For the purposes of
such a visual analysis, for fast zooming of the peak according to the size of the spectrum window,
to return to normal zoom.
double click on the peak title with the left mouse button, or press
6.2.10 Then, the result of determining of activities may be converted to a protocol, MS
Word, report or database. For these purposes, there is a toolbar similar to that described in section
5.1 and located above the Found Peaks table ( - saving data to a txt protocol;
- sending data
to MS Word;
- generating a report; - sending data to a DB).
6.2.11 To save the found peaks and all the other parameters entered in the Spectrum
parameters window, press . After that, when you open this spectrum, marking with found peaks
will be done automatically. The list of peaks and their parameters are saved in the file having the
same name as the spectrum, but with an *.asr extension.
To consider background in the calculation of activities, it is necessary to link it in the
Background field in the Spectrum parameters window. The spectrum background should be
measured with good statistics, as well as processed similarly to the work spectrum. The table of
found and identified peaks of the background spectrum is saved automatically together with the
spectrum in the same way. The program loads the table of background peaks, when opening the
work spectrum or when the background spectrum in the work spectrum changes.
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6.3 Adjustment of found peaks
Peaks can be searched in two modes 'Search and Identification' and 'Peaks from library'.
In the first case, the search is made according to the parameters specified in spectrum parameters
(search range, smoothing, etc.), and all the peaks meeting these requirements are recorded. In the
second case, only those peaks are highlighted, which match the energy lines specified on the
Library tab.
As shown in section 6.2, when you press

, a new search for peaks is performed. To adjust

found peaks in order to recalculate their peak area and also activity, use
(Update calculation for
found peaks), which is also located on the toolbar of the spectrum window. It is used, if the position
of peaks is correct, but the description of their curve is incorrect, or when adjustment by the
benchmark peak is used.
As peaks are identified automatically, some peaks may be recognised incorrectly, therefore,
the identification result may be adjusted manually in the 'Line' column of the table using the
dropdown list with energy lines getting in the energy limit (see Spectrum parameters window).
If spectra are complex, you can use curve description adjustment of some peaks by
benchmark. If the radionuclide has several peaks and one singlet, the latter may be taken as a
benchmark by checking 'Benchmark' in the table. Then, having loaded the efficiency file, you can
on the toolbar. For the other peaks (which are not benchmarks),
make a recalculation by pressing
their estimated height for further processing will be calculated. Thus, the credibility of splitting of
multiplets into components will increase.
6.4 Inserting and deleting peaks
The toolbar of the spectrum window contains a group of three buttons as shown on Figure 39
(in a frame).

Figure 39. Identification button group view
Thus, the
(Insert peak mode) button is intended for toggling to the insert peak mode.
In this mode, the mouse cursor becomes a green down arrow (see Fig.40.1). To insert a found peak
to the specified position, set a marker in the peak centroid region and double click with the left
mouse button, then the peak will be highlighted and added to the table of found peaks (see Fig. 40.2,
block 3). For insertion, you can use double click or press the Insert key on the keyboard.
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Figure 40.1. Preparation of a marker for peak insertion

Block 1
Block 2

Block 3

Figure 40.2. New inserted peak
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Figure 40.3
A found and described peak in the spectrum has a Gaussian curve outline as shown on Figure
40.3. There is a peak title near the Gaussian curve describing the peak (see Fig.40.2, block 1, and
Fig.40.3). If the peak has been identified, the title contains peak energy and the name of the
radionuclide.
When hovering a cursor over the peak title, a popup prompt appears (see Fig.40.2, block 2)
containing peak parameters, such as channel, energy, radionuclide name, FWHM, resolution, area
and intensity. Once the cursor is at the 1332.5 keV peak’s title, there appears a pop-up hint which
displays the Peak-to-Compton ratio. For the 5.9 keV peak, the Peak-to-Background ratio will be
shown.
To select a peak, left click on its title. If you double click on the title, this peak will stretch
according to the length of the spectrum.
If you right click on the title, a popup menu will appear as shown on Figure 40.4.

Figure 40.4
In this menu, Show peak in separate window selects this peak and opens it in the Peak
window (see section 4.2).
Send to energy calibration and Send to FWHM and shape calibration make it possible
for the user to add data of the peak being viewed to energy calibration and FWHM and shape
calibration.
The
(Delete peak) button of the toolbar of the spectrum window is intended for the
deletion of a peak from the list of found peaks.
The procedure of deletion of a peak is as follows. Exit the insert peak mode by pressing
again, so that the cursor returns to its standard view. Then select a peak to delete. To do this, you
can use peak selection in the table by selecting the peak you need. You can also select a peak by left
clicking on the peak title. In either case, the peak will have a bold green outline and the row
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corresponding to it will get selected in the table. When a peak has been selected, press
toolbar of the spectrum menu.
If you want to delete all the found peaks, there is a

on the

(Delete all) button.

6.5 Sending of a list of peaks to calibration
The toolbar above the table of Found Peaks contains additional buttons
(see Fig.38,
block 5). These buttons are intended for sending of data about found peaks to peak FWHM and
shape calibration. It should be noted that even though the information about the FWHM and shape
value is not available in the Found Peaks table, this information is stored in the program and may
be sent to dialogue windows generating FWHM and shape calibrations.
To send data to calibration, in the tables of found peaks select those peaks, which you want
to convert (see Fig.41), and press
(Send selected peaks to energy calibration) or
(Send
selected peaks to FWHM and shape calibration), depending on the target calibration.

Figure 41. Selection of peaks for sending to calibration
When you press these buttons, a dialogue window of the relevant calibration will open.

6.6 Database
The program ASW2 allows not only to save the measurement results into database (DB) file but
also to operate with it directly in the program. For successful work with DB, the availability of those
database file (*.accdb) is required and the path to it is specified in the window Parameters in insert
Files in the field Database filename (see section 10, Fig.52.1).
To activate the database the operator should select the item Tools->Database in the program
main menu ASW2. The window Database of measurements will appear as presented in Fig 41.1. The
figure shows that the window has several units. Unit 1 (Fig.41.1) comprises the list of the saved records
as a Table, where the spectrum name, sample number as well as the data and the measurement time of
the present record spectrum are specified. Unit 2 – instrument panel for the record table control, it
contains the button for the spectrum restoration from DB, record delete and filtration (search)
adjustment button by DB.
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Unit 2

Unit 1
Unit 4

Unit 5

Unit 3

Figure 41.1. Window Database of measurements
Block 3 has standard fields with the parameters of the current spectrum (selected in Unit 1

table).
Block 4 has two tabs ROI-method and Peaks analysis. Each of the tabs has a table with the
calculation results of the activity, errors etc., which were obtained on the stage of calculation with the
current spectrum (see p.p. 5.1, 5.2, 5.3, 6.2). In dependence on the calculation method, the data are kept
on one or another insert. And if the calculation was made by both methods, then the data will be
presented on both inserts accordingly. For additional signalization on the calculation results presence,
for the current record, there is a mark near the name of the insert. Above the table with the calculation
results there is a button , which allow to see in a separate window the additional data on the executed
measurement (see Fig.41.2).

Figure 41.2. Additional data window on the executed calculation
Block 5 (Fig.41.1) shows the diagram of the spectrum, marked in table, where there are channels
by X axis and count rate values in pulses by Y axis.
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New records in DB could be added directly from the spectrum window by the button
,
situated in the inserts ROI-method and Peaks analysis, placed in the window Calculation results (see
Fig.30 and Fig.38, unit 5).
To filtrate the records by database there is a search instrument which is activated by the button
in instruments panel (Fig.41.1, unit 2). When that button is pressed, the window Filter appears as
shown in Fig. 41.3.

Figure 41.3. Window Filter
Changing the values of the present window fields, the user can make filtration and search by
data base, switching the time period for spectra measurement. For the application of the specified search
parameters the button Filter should be pressed, the table (Fig.41.1, unit 1) will display only records
which correspond the specified search criteria.
As data base save all content of the measured spectrum, it could be restored and a new spectrum
will be absolutely identical to the initial one, including the name of the file. To execute the present
procedure, the required record in the table should be marked and the button
should be pressed. If
the spectrum file with that name already exists then the program will inform that. To avoid the rewriting
of the existing spectrum with the same name, the name of the file will added with '_db'.

7 Energy calibration
Before identification, it is necessary to match the energy value with the analyser’s channel
number, i.e. perform energy calibration of the spectrometer. Spectra of standard sources of γ
radiation are entered for this purpose. The spectrum, which participates in energy calibration, must
contain several well-shaped peaks. The procedure should be periodically repeated depending on the
stability of operation of the source of high voltage, amplifier and analyser.
For energy calibration of a selected spectrometric tract, select this tract on the Device
manager panel. Then, press
Figure 42.

and a dialogue window will appear on the display as shown on
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Block 2
Block 1

Block 3

Figure 42. Energy calibration window
On the left side of the window, there is a table (Fig.42, block 1) containing three columns
'Channel', 'Energy (library)', 'Energy (calc.)'. The table contains information about lines (peaks),
which are the basis for energy calibration.
Thus, Fig.42 shows calibration consisting of two points, which describes the dependence of
energy on channel in the spectrum. To calculate functional dependence, the user should press the
Calc calibration button (Fig.42, block 3), and the received formula will be displayed in the Result
field. Also, after the calculation, the graph (Fig.42, block 3) will show the found dependence.
If there are more than two points in the table, the program may determine the parameter of
integral nonlinearity (INL), which is displayed in the INL field in block 3. Also, in this case a
polynomial dependence of second degree can be built. To do this, set the value of 2 in the
Polynomial degree field.
The user may add and remove points from the table. To do this, use
(Add item) and
(Delete item), which are located above the table. Thus, if you press , a new row will appear in the
table, which the user should fill with values of the field in the 'Channel' and 'Energy (library)'
columns.
If you want to start generating a new calibration, there is a
(Delete all) button located
above the table. When you press this button, the table will keep two rows, which are minimally
necessary for plotting a straight-line correlation. You can edit the table by editing fields in these
rows.
Data can be brought to the table in several ways:
- from the table of found peaks in a processed spectrum (section 6.5, Fig.41);
- from the window for work with peak (section 4.2, Fig,25);
- from the peak title context menu (section 6.4, Fig. 40.4).
To get a prompt of the library energy value in the field of the 'Energy (library)' column, in
the editing mode there is a possibility to open a library window (see Fig.43.1). This function is
available, if a library file is specified in the Library file field.
To open the library window, press
at the right edge of the field.

Figure 43.1
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Then, a window for selection of an energy line from the library will appear on the display
(Fig.43.2).

Figure 43.2 Window of energy selection from the library
The user may select a radionuclide and a line from the list provided in the left table. When
you double click on the selected energy, the library window will close and the energy value will be
populated in the table field of the Energy calibration window.
You can also use library search. For this, in the Energy, kev field in the right portion of the
Radionuclide library window, specify an approximate energy value, which should be found in the
library and having specified the range of search in the next field, press Search. As a result, the right
table will display lines corresponding to the set condition. The user may select the required variant
from the list by double clicking on the respective row with the left mouse button.
When you have received the searched functional dependence for energy calibration, it should
be applied to the current spectrometric tract. To do that, press Apply at the bottom of the Energy
calibration window.
To save to a file and load all the calibration data, use Save and Open, respectively.
The Energy calibration window allows the user to generate a text report to receive and print
summary information. For this purpose, there is a Report button in the bottom part of the window.
When the calibration is over and you press this button, the window shown on Fig.44 will appear.

Figure
44.
Energy
calibration report view
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To print a report, press
.
To perform energy calibration for the specific work spectrum, open this spectrum and press
on the toolbar of the spectrum window, and then a dialogue window similar to that shown on
Figure 42 will appear. The only difference will be the availability of an additional button Apply to
tract at the bottom of the Energy calibration window. This button is intended for the applicable of
the new calculated calibration to the spectrometric tract, which corresponds to the spectrum being
viewed.

8 FWHM and shape calibration
FWHM (full width at half maximum) calibration is a procedure of searching functional
dependence of the FWHM parameter on the channel in the spectrum.
The term ‘peak shape calibration’ in ASW2 is defined as a search for dependence of T
parameter (the so-called ‘left edge’) on the peak centroid channel in the spectrum. T parameter is the
distance in channels from the peak centroid to the left, after which the peak is described with
exponential dependence rather than Gauss (see Fig.45).

Figure 45. Shape of the graph describing a peak
For FWHM and shape calibration of a selected spectrometric tract, select this tract on the
Device manager panel. Then, press
shown on Figure 46.

and a dialogue windows will appear on the display as
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Block 2

Block 1
Block 3

Figure 46. FWHM and shape calibration window
On the left side of the window, there is a table (Fig.46, block 1) containing three columns
'Channel', 'FWHM', 'Left edge (shape)'. The table contains information about lines (peaks), which
are the basis for FWHM and shape calibration.
Thus, Fig.46 shows calibration consisting of a certain number of points, which describe the
dependence of FWHM and shape on channel in the spectrum. To calculate functional dependences,
the user should press Calc calibration (Fig.46, block 3), and the received formula will be displayed
in the Result for FWHM and Result for shape fields. Also, after the calculation, the graph (Fig.46,
block 3) will show the found dependences.
If there are more than two points in the table, polynomial dependences of second degree can
be built. To do this, set the value of 2 in the Polynomial degree for FWHM and Polynomial
degree for shape fields.
The user may add and remove points from the table. To do this, use
(Add item) and
(Delete item), which are located above the table. Thus, if you press , a new row will appear in the
table, which the user should fill with values of the field in the 'Channel', 'FWHM' and 'Left edge
(shape)' columns.
If you want to start generating a new calibration, there is a
(Delete all) button located
above the table. When you press this button, the table will keep two rows, which are minimally
necessary for plotting a straight-line correlation. You can edit the table by editing fields in these
rows.
Data can be brought to the table in several ways:
- from the table of found peaks in a processed spectrum (section 6.5, Fig.41);
- from the window for work with peak (section 4.2, Fig,25);
- from the peak title context menu (section 6.4, Fig. 40.4).
When you have received the searched functional dependences for FWHM and shape
calibration, they should be applied to the current spectrometric tract. To do that, press Apply at the
bottom of the FWHM and shape calibration window.
To save to a file and load all the calibration data, use Save and Open, respectively.
The FWHM and shape calibration window allows the user to generate a text report to
receive and print summary information. For this purpose, there is a Report button in the bottom part
of the window. When the calibration is over and you press this button, the window shown on Fig.47
will appear.
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Figure 47. FWHM and shape calibration report view
To print a report, press

.

To perform FWHM and shape calibration for the specific work spectrum, open this spectrum
and press
on the toolbar of the spectrum window, and then a dialogue window similar to that
shown on Figure 46 will appear. The only difference will be the availability of an additional button
Apply to tract at the bottom of the FWHM and shape calibration window. This button is intended
for the applicable of the new calculated calibration to the spectrometric tract, which corresponds to
the spectrum being viewed.

9 Efficiency calibration
9.1 General statements
The calibration of a spectrometer by registration efficiency is performed using the reference
samples reproducing the geometry and properties of gamma-ray absorption of the measured sample.
As a result of calibration, energy dependence of registration efficiency in peaks of complete
absorption of gamma quanta radiated by sample (reference) measures is determined. When it is
necessary to take into account absorption of gamma-quanta in the material of a bulk spectrometric
preparation, energy dependences of registration of gamma-quanta are determined using several sets
of reference bulk measures with different density of filler materials.
The calibration process is conditionally broken down into four stages:
− measurement of spectra of sample activity measures or receiving these spectra via calculations
using a specialised program, which simulates interaction of radiation with the substance;
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− processing of spectra for the purposes of searching, identification and determining areas of
peaks;
− calculation of efficiency of registration of gamma-quanta based on gathered spectra of the set of
sample measures and approximation of energy dependences of efficiency of registration of
gamma-quanta;
− creation and saving of an *.efp calibration file.
The dependence of efficiency of registration of εn on energy of gamma-quanta En is
described by functional dependence 9.1:
ε п ( E n ) = exp( A0 + A1 ln E п + A2 (ln E п ) 2 + A3 (ln E п ) 3 + A4 (ln E п ) 4 + A5 (ln E п ) 5 + A6 (ln E п )6 ) (9.1)
where Ai are polynomic coefficients determined in the process of calibration, i=0..6.
Appendix 2 shows an *.efp file format.
Since registration efficiency calibration is the basis for correctness and accuracy of
measurements, these operations must be fulfilled by a highly qualified specialist, or a representative
of the company in charge of supply and setting of the gamma spectrometer.
9.2 Selection of radionuclides for calibration
Calibration requires sample measures of activity or calibration sources (hereinafter referred
to as calibration sources) with activity within the range (1 - 100) kBq, produced based on working
standards of radionuclide solutions of the 1st order 54Mn, 57Co,109Cd, 113Sn, 137Cs, 139Ce, 152Eu,
241
Am, 243Am, 226Ra (with daughters), 228Th (with daughters), etc.
The activity of the calibration source is chosen based on the condition that, when setting a
spectrum in the working geometry of measurement, “dead” time does not exceed (4-5)%.
The quantity and radionuclide composition of calibration sources for the efficiency calibration
task in the range of energies 50 – 3000 keV is chosen, assuming that no less than 4 efficiency
values, which correspond to different energies of gamma-quanta, should be received in the interval
of energies 50-200 keV, and also energies must correspond to the beginning, middle and end of the
energy range, and no less than 4 efficiency values meeting the same requirements should be
received in the interval of energies 200-3000 keV.
9.3 Management of spectra
To load and delete spectra in the Efficiency calibration window, use
buttons on the toolbar of the window.
After spectra have been loaded, their list appears in a table (Fig.48, block 4) or as shown on
Figure 50. Histograms of spectra are displayed on a graph (Fig.48, block 4 or Fig.50).
To show or hide a histogram of a spectrum, check or uncheck it in the first 'N’ column of the
table.
The information with parameters of the current (selected in the table) spectrum is displayed
on the panel under the graph of spectra (see Fig.48, block 6). To be noted, the histogram of the
current spectrum is displayed on a graph with a bold red line.
To move the current spectrum up or down the table, use or buttons.
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9.4 Efficiency calibration procedure
9.4.1 Measure spectra of reference samples for one geometry or simulate these spectra using
the programme implementing calculation methods. Spectra for various distances between the sample
and the detector can be used for the same geometry.
9.4.2 Generate files of passport data of calibration sources. To do this, use the Reference
source certificate editor window, which can be opened from the main programme menu Options->
Reference source certificate editor (see section 13).
9.4.3 Process the spectra received in p.9.3.1 for the purposes of searching, identification and
determining areas of peaks as described in section 6.
9.4.4 For each spectrum of the calibration source, set its own file of passport data. To do this,
specify a link to the file of passport data in the Passport of source field in the Spectrum
parameters window of each spectrum.
9.4.5 Save processed spectra to a disc.
on the toolbar
9.4.6 Open the Efficiency calibration window (see Fig. 48) by pressing
of the programme. Choose tab Efficiency calibration which is the first tab in the window’s title.

Figure 48. Window Efficiency calibration

9.4.7 In tab Efficiency calibration, using Add on the toolbar, load all the calibration spectra,
then range them in such a way that the spectra with one density (or other parameter) are grouped.
(See example on Fig.49).
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Spectra of samples with
density 0.2 g/cm3
Spectra of samples with
density 1 g/cm3
Spectra of samples with
density 2 g/cm3
Figure 49. Ranging of spectra
9.4.8 Set parameters of the efficiency curve (Fig. 48, block 1):
- Polynomial degree – the parameter determining the polynomial degree, which will be
calculated for the purposes of describing experimental dependence of registration efficiency on the
energy of gamma-quanta.
- Range, keV – the range of energies, within which the dependence of the registration
efficiency on the energy of gamma-quanta will be built.
- Geometry – name of geometry of measurement, for which calibration by efficiency is
created. It is a mandatory text parameter, whose value will be saved in the efficiency file and will
show in the data field about implemented calculation (see Fig. 41.2). In the drop list of this field is
offered conventional labels for often used geometries ('Mar' – Marinelli, 1L; '38_' – container, 38ml,
'250' – cuvette, 250ml; etc.). Radioactivity calculation can only be performed if measurement
geometry is specified in the efficiency file.
9.4.9 Press Calculate calibration (Fig. 48, block 1), then the table (Fig. 48, block 2, and
Fig.50) will show a tree with data on efficiencies, and the graph below will display the curves
approximating calculated points of values of efficiencies (Fig. 48, block 3, and Fig.50).
The coefficients of the approximation polynom are displayed near the density value for each
parameter combination (density and distance). This looks like this:
Eff=f(-1343, 1307, -5133, -1649, 248.2, -19.85, 0.6592)
9.4.10 The points, which are at a good distance from the curve, are rejected by unchecking
the relevant row in the table, and the appearance of the curve changes automatically. To change the
energy range for calculation of efficiency curve, specify the values in the fields and click button .
9.4.11 To explore the shape of received curves, you can toggle the scale to the logarithmic
mode. To do this, you should check Log located on the panel (Fig.48, block 1). The appearance of
the graph will change, and will look as shown in Fig.50.1.
9.4.12 When the appearance of efficiency curves has finally shaped, an efficiency calibration
file for the accepted measurement geometry is created, which has a unique name and an *.efp
extension. To do this, press Create file and then enter the name of the new calibration file in a
standard dialogue.
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Figure 50. Window Efficiency calibration after calculation of dependence of efficiencies on energy

Figure 50.1. View of efficiency curves on a logarithmic scale
9.4.13 If necessary, implement all the stages for calculation of efficiency curves (see sections
9.4.1 - 9.4.12) for other geometries.
9.4.14 In order to merge all the efficiency files into a file, choose tab Calibration manager
(see Fig. 50.2) and load the files created by steps 9.4.1 - 9.4.13 by means of button
. The data
from the files loaded will be shown in a table, whereas the efficiency curves will be shown in a plot
under the table.
Choose a calibration row in the table to highlight the corresponding curve in the plot with red
color. To hide a curve in the plot, untick the corresponding row in the first column of the table.
The Distance and Density values can be changed for each curve by changing the values in
the same-named columns in the table.
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Figure 50.2. Tab Calibration manager
9.4.15 Lastly, click button
and specify a new name to save the efficiency file comprising
a few efficiency curves. Prior to saving, the curves that are not relevant can be deleted by clicking
button

.
9.5 Creating an efficiency file project

As creation of an efficiency file may take a longer time, saving a current configuration of
calibration spectra, selected energies and parameters for further operation might be relevant. To this
end, one can save the current configuration as a separate project file. What is more, all the spectra,
library files and passport data files will be moved to a common directory featuring a certain
structure.
To create a project file, click button
in the toolbar of tab Efficiency calibration. A
window will appear on the screen. In this window, specify the name of the project and directory,
where the project itself and all the relevant files will be moved (one is recommended to create a new
directory) (see Fig. 50.3).

Figure 50.3. Window requesting the name of efficiency file project and a directory for it
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Click button Save to create three subdirectories SPC, LBR and PKS in the project’s
directory specified by user. The spectra, library files and passport data files related to them will be
automatically copied to the respective subdirectories. In the project’s directory, there will appear a
*.pef file which contains the data on the project’s parameters.
Later on, when ASW2 is closed and then opened again, the user will be able to load the
project by clicking button
in the toolbar of tab Efficiency calibration and selecting the saved
project’s file there. The software will automatically load all the spectra and restore the configuration
saved, so that the user will be able to continue creating the efficiency calibration file.

9.6 Creating an efficiency file from a text table
Tab Converting in window Efficiency calibration is used to convert the text table (text file)
which contains three value columns (energy, efficiency and standard uncertainty) to the efficiency
file of the ASW2 format.
To this end, the user should choose tab Converting (see Fig. 50.3) and open the text file by
in the tab’s toolbar. Once the file is opened, the software immediately starts to
clicking button
perform calculation in accordance with the parameters (degree of a polynomial, energy range)
specified in the toolbar. These parameters are changed in the same way as in tab Efficiency
calibration. The values in the table can also be turned on and off by ticking each row in the first
column named Energy. The resulting polynomial function of the detection efficiency versus energy
will be displayed in the toolbar.
When calibration is created, it should be saved as an *.efp file by clicking button Create file
in the tab’s toolbar.

Figure 50.3. Tab Converting
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10 Parameters
The Parameters window of the table is intended for setting some details of work of the
program. It can be opened from the main menu Options->Parameters and contains 4 tabs General,
Files, View, Calculation (see Fig.51).

Figure 51. Parameters window view
The General tab (Fig. 51) contains a block of parameters GPS, which has two fields for
setting a GPS satellite navigation unit. If a GPS receiver is connected and data are correct, the
current coordinates can be sent to fields of the GPS coordinate group.
The Files tab (Fig. 52.1) contains the name of the database file for saving the results of
calculation of activities of radionuclides (Database filename field) and the protocol filename
(Protocol filename field), which can contain the consolidated result of measurements in a text
format.

Figure 52.1 Files tab view
The View tab (Fig.52.2) is intended for setting the external interface of the device manager.

Figure 52.2 View tab view
The Calculation tab (Fig.52.3) is intended for setting some aspects related to measurements
and the procedure of calculation of activities.
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Figure 52.3 Calculation tab view
The Calculation tab contains several blocks containing the following fields:
Calculate Aeff – an indicator telling the program that it needs to calculate a parameter of
efficient activity, which is determined according to formula 10.1 (see the "Description of
Algorithms Implemented"):
(10.1)
Аeff = АRa +1.30·ATh +0.090·AK
where АRa is specific activity of radionuclide Ra-226, Bq/kg;
АTh is specific activity of radionuclide Th-232, Bq/kg;
АK is specific activity of radionuclide K-40, Bq/kg.
Efficiency activity is determined, when activities are calculated according to the ROI-method
or peak analysis method and is displayed on the results panel as shown on Fig.30. The calculation is
made, if there is a calibration for determining activities of natural radionuclides (NRN).
Show the class indicates if the danger class of the material should be determined.
Aeff < 370 Bq/kg – danger class I;
370 Bq/kg < Aeff < 740 Bq/kg – danger dlass II;
740 Bq/kg < Aeff < 1500 Bq/kg – danger class III;
1500 Bq/kg < Aeff < 4000 Bq/kg – danger dlass IV;
4000 Bq/kg < Aeff – danger class cannot be determined.
This data including Aeff will be displayed in the results panel provided that natural
radionuclides Ra-226, Th-232 and K-40 are in the list.
Save measurement in log – an indicator telling the program that it needs to automatically
send the measurement results to a log in the process of saving a measured spectrum.
Signal about measurement finish – a checkbox, which allows to enable and disable a sound
signal at the end of spectrum writing.

Figure 52.4 MDA tab view
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The MDA (fig.52.4) tab is designed to configure some aspects associated with the
calculation of the minimum detectable activity (MDA).
The MDA tab contains several blocks containing the following fields:
where the parameter k and a– sets the value of the coefficient k and a in the formula
shown in Figure 52.4. This formula calculates the MDA value.
Type of view results with uncert. more 50% – an item for choosing the format of display
of the measurement result with expanded uncertainty above 50%. Values may be displayed in two
formats:
"<MDA"
"MDA/2 ± 100%".
The first result output variant is more correct from the point of view of metrology.

11 Pack of spectra
The Pack of spectra module is opened from the main program menu Tools->Pack. It is
intended for work with any series of spectra (display, mathematical operations, determination of
stability, calculation of activities, etc.).
Switching between linear and
logarithmic scale
Switching
between count and
intensity

Block 2

Block 1

Figure 53. Pack of spectra module
Block 3

The Pack of spectra module consists of three main blocks and a menu (Fig.53).
Block 1 is a table, which contains the list of loaded spectra. The first column of the table
contains a spectrum number in sequence and a checkbox, which shows whether this spectrum should
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be displayed in block 2. When you press on the column header
, it enables or disables
displaying of all the spectra.
The second column contains filename of spectra with their paths. Columns 3, 4 and 5 are
intended for the display of results by determination of stability (see below).
If a cursor is set in any row, the spectrum concerned is shown on the graph in red. You can
select one, two and even all the rows in the table. The last selected spectrum has a red bold line on
the graph. To select several spectra, press and hold Ctrl on the keyboard and press on the row you
want to select with the left mouse button. If you want to deselect a row, press with a left mouse
button on any selected table cell. A left double click on any row causes standard opening of a
spectrum within ASW2.
Block 2 contains a graph, which displays on the selected spectra in the table on a single
automatic scale.
Press the

button in the menu to add spectra to the table, or press the

delete, first selecting necessary spectra in the table. To delete all the spectra at once, press

button to
.

Block 3 is intended for management and all kinds of operations in the Pack of spectra
module. It consists of several tabs (Current, Math. operations, Stability, Activity, Calibration,
Sensitivity control, Background control, Normalization, Map), each of which is responsible for
respective functions.
The Current tab (see Fig.53) displays all the information about parameters of the last
selected spectrum in the table (block 1). The list of parameters on the Parameters and Additional
tabs fully duplicates the list provided on the “Spectrum parameters” tab (see Fig.20 and Fig.36)
when you work with the spectrum window.
(Save current change) and
There are two buttons on the toolbar of the Current tab:
(Template). The first is for saving changes made to fields of the Parameters and Additional tabs.
button provides the user with a Template tool, which is intended for measuring one or
The
several parameters of selected spectra. When you press this button, the Template of parameters
window (see Fig.54) will open.

Figure 54. Template of parameters window
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Edit one or more parameters and check this field on the right. Then, in the main list of
spectra, select the spectra, to which these changes should be applied, then press Apply in the header
of the Template of parameters window. As a result, you will see a message about the manipulation
you have made.
The
(Get parameters of current spectrum) button is necessary in the cases, when it is
necessary to get parameters of one spectrum and use them as a template for other spectra.
The Math. operations tab consists of 3 blocks (Fig.55) and is intended for summing and
subtracting spectra.

Figure 55. Math. operations tab content
To add several spectra and make them one:
- select the spectra intended for summing in the main table (Fig.53, block 1);
- select ‘Sum’ in the dropdown list of the Operation field (Fig.55);
- select the option corresponding to the type of summing (channel-by-channel or in the
energy scale);
- in the Ext.parameters block, select Spectrum as shown on Fig. 55, the field with the
dropdown list should be empty;
in the field below and
- in the Result block, select Filename for new spectrum, press
select a path and the name for the sum spectrum.
- press Calculate. A new summary spectrum will be created as a result of the actions above.
There is a Sum time checkbox in the Ext.parameters block. It is intended for changing the
type of the resulting summary spectrum by time criterion. Thus, for instance, you should check this
checkbox, when summing spectra of the same type received from one detector or from one source.
By doing this, you will sum count and time in the resulting spectrum. Thus, we will receive an
averaged spectrum with improved statistics. In other case, when summing spectra from difference
sources, disable the “Sum time” mode. Then the resulting spectrum will have time as the first
spectrum being summed (the so-called adjustment to the time of the first spectrum).
To add several spectra with one spectrum:
- select the spectra intended for summing in the main table (Fig.53, block 1);
- select ‘Sum’ in the dropdown list of the Operation field (Fig.55);
- select the option corresponding to the type of summing (channel-by-channel or in the
energy scale);
- in the Ext.parameters block select Spectrum as shown on Fig. 55;
- in the field with the dropdown list select the spectrum, with which you will sum the
spectra selected in the table;
- in the Result block, select Mask for new spectra, and in the field below enter a mask, for
new spectra, to make them different from the original ones;
- press Calculate.
As a result of this, files of spectra summed with one spectrum will be created on a disk.
To subtract a spectrum from several spectra, you should do the same operations with the
exception of the type of operation in the Operation field. You should select ‘Sub’ here.
64

Spectra can be summed and subtracted with a constant. To do this, in the above-mentioned
algorithms specify Constant instead of Spectrum and enter the constant value in the field below.
The Stability tab is intended for determining stability of the spectrometric tract by spectra.
Thus, for instance, to receive a graph of dependence of the 137Cs radionuclide peak position in a
spectrum on time, the set of spectra should be measured in an automatic mode. Load the received
pack of spectra to the Pack of spectra module. Select all the spectra. On the Stability tab (Fig.56,
block 1) in the Find in range block, specify the approximate location of the peak, check Centre and
press Calculate. Fill in columns 3, 4 and 5 in the module table. The graph on the Stability tab will
show the dependence you seek. You can copy the received graph to clipboard by pressing To
clipboard. To make selection of the window with the peak easier, use Auto (in the Find in range
block). This button gets fixed in this state, when you press it. Then, you can double click with a
marker on the spectrum in the place of the left window edge and then in the place of the right edge.
The graph range will get selected (see Fig.56). Then you can press Calculate again.

Figure 56

Block 1

Sigma, Resolution, Integral and Intensity checkboxes are intended for displaying on the
graph not only the centroid of the peak, but also FWHM (full width at half maximum) value,
resolution value calculated based on the peak shape, as well as integral and intensity. The Find in
range group contains an option for entering window edges in channels and in energy values (keV).
The Sensitivity control tab (Fig. 57) is intended for detector sensitivity control. The program
evaluates the difference between measured and passport values of activities of radionuclides in the
control sample taking into account errors in their determining.
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Figure 57. Sensitivity control tab view
Select necessary spectra in the main table to perform the control. In tab fields, consecutively
load the file of passport data of the control samples, the background spectrum and the file of
calibration by ROI-method. Press Control. The result looks as shown on Fig. 57.
The Background control tab (Fig.58) is intended for a standard mathematical operation,
which allows evaluating the unchangeability of the unit background by comparing the measured
spectrum with the background spectrum.

Figure 58. Background control tab view
Select necessary spectra in the main table to perform this operation. In fields of the
Background control tab consecutively load the background spectrum and the file of calibration by
ROI-method. Press Control. The result looks as shown on Figure 58.
The Activity tab (Fig.59) is intended for the calculation of activity of radionuclides using the
ROI-method. For a series of spectra, the procedure is the same as for a single spectrum (see section
5.1).
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Block 2
Block 1

Figure 59. Activity tab view
It is possible to calculate activities for a series of spectra from the Activity tab only using
one calibration file and one background spectrum. To do this, select necessary spectra in the main
table. In tab fields, consecutively load the background spectrum and the calibration file. Press the
Calculate button. The result looks as shown on Fig. 59.
Block 1 on Fig. 59 has checkboxes, which will show the column in the results. Calculated
activities and errors are shown in table as a tree. To look at the values of any specific spectrum,
press on
in the respective row and hidden data fields will appear. If you need to show all the
values at once, press on the Spectrum column heading, when you press again, all the fields will be
hidden.
Under block 2 (Fig.59), there is the Calculate MDA checkbox. When checked, the table will
display minimum detected activity and specific (volume) activity instead of activity, when relative
error is higher than 50%.
Block 2 on the Activity tab is for exporting results to data storages, for example, a text file,
MS Word, a report and a database. Check one of the options in block 2 and press Transfer. The
content of the resulting table will be transferred according to the selection.

12 Radionuclides library editor
The radionuclides library editor is intended for generation of files, which are used in the
calculation of activities, identification of radionuclides and for other spectrometric tasks. These files
should be shown in the Library file field in the Identification section of the Spectrum parameters
window (Fig.20 and Fig.36).
A library file contains the list of radionuclides with respective energy lines and their
quantum outputs. The program can handle library files of two types (*.bib and *.lbr). The first one
(*.bib) is a text file and has a structure of the so-called ini-file; the second one (*.lbr) is also a text
file, but it has other, more old-fashioned structure. Both files may be formatted and edited manually
(in any text editor), or you can also use the Radionuclides library editor module.
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To open the editor, select Options->Library editor in the main program menu. A window
shown on Figure 60 will appear on the display.

Block 3

Block 1

Block 4

Block 6

Block 5

Block 2

Figure 60. Radionuclides library editor window view
It looks like two symmetrically located blocks, which contain a table (block 1 and 2, Fig.
60), a toolbar and a block of display parameters (blocks 3 and 4). The functionality of the blocks is
absolutely the same, which allows forming libraries using elements of both. Use arrow buttons
(block 5, Fig. 60) to move radionuclides from one library to the other.
The ASW2 installation package usually contains one or more libraries, from which you can
make individual libraries for specific tasks. To do this, you need to load an already available library
from the toolbar editor to the left block using
. Then select necessary radionuclides and press
(Copy selected radionuclides). Selected items will appear in the right table, then you can add
something to it, edit and save it. Items from the right table can be copied to the left table in the same
way.
To edit names of radionuclides, energies, etc., double click on the current value with the left
mouse button and the field will switch to the editing mode. To finish editing, press Enter.
To add a radionuclide to the table, press
(Add radionuclide). A new row with the name
of the radionuclide 'Nu' with one energy line will appear. The new row will appear above the
currently selected row. To add a radionuclide to the end of the table, deselect the current selection.
To do this, left click on the field under the table, to the right of the Parameters group (Block 6, Fig.
60). The new row should be edited according to characteristics of the item to be added.
To add energy line of a radionuclide, select this item with a cursor and press
(Add
energy) on the toolbar. In the new row, you should replace default values with necessary ones
(energy, quantum output, quantum output error).
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To remove a radionuclide and its energy lines, use
(Delete selected radionuclides) and
(Delete selected energies), respectively. To clear the entire table, use the
(Remove all)
button.
When you have finished editing the table, you can save it in any of the two formats. To save,
press
(Save library file) on the respective toolbar. Please note that the *.lbr library format does
not support saving of the so-called “checking/unchecking” of items and their lines.

13 Passport of source editor
The Passport of source editor is intended for generation of files of passport data of sources,
which are used during efficiency calibration of the spectrometer. These files should be shown in the
Source reference data field in the Identification section of the Spectrum parameters window
(Fig.20 and Fig.36).
To open the editor, choose menu option Options-> Passport of source editor in the main
menu or click button

in the toolbar. A window shown on Figure 61 will appear on the display.

Figure 61. Passport of source editor window
A passport of source file contains a list of radionuclides, their activity, uncertainly, as well as
other parameters describing the source.
Figure 61 shows an example of completion of the form in the Passport of source editor
window.
Complete the following fields in the left part of the window:
Geometry – source geometry, the text field may be filled manually or its value can be
selected from a dropdown list.
Mass | Unit – source weight and weight unit.
Volume | Unit – source volume and volume unit.
Reference date and Reference time – date and time of adjustment of activities specified in
the table to the right. Please note that all the activities in the table must be adjusted to this date and
time.
Source ID – source identifier or number, a text field.
On the right side of the Reference sources library editor window there is a table, where the
user should enter data about radionuclides present in the source. To add a row, press
(Add
radionuclide) above the table. Then, it is necessary to fill empty fields with values from the source
certificate. To make it easier to enter the data about the name of the radionuclide, the user may
select it from the list, which appears in the editing mode in the 'Radionuclide' field (see Fig.61.1).
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Figure 61.1 Selection of a radionuclide from the library
To make a dropdown list available, it should be loaded from a library file in format described
in Section 12. To load a library file, double click on the status bar of the window and load the
required file using a standard file selection dialogue. The name of the loaded file will be shown on
the status bar.
To delete a row or clear all the list of radionuclides shown in the table, use
(Delete
radionuclide) and (Delete all radionuclides) buttons, respectively.
If data is changed in column 'Abs.expanded uncertainty', the value in column
'Rel.expanded uncertainty' change automatically and vice versa since the values in these columns
correlate. The user can introduce the data in either column considereng which type of uncertainty is
specified in the source’s certificate.
To finish the creation of a passport of source file, save it as a file. To do this, press Save on
the toolbar of the window and specify a new filename.
To load an existing passport of source file for viewing and editing, use the Open button.
Additionally, one can calculate a radionuclide’s activity for any date. To this end, choose a
radionuclide in the certificate’s list and click button
in the toolbar of window Reference
sources certificate editor to open window Decay calculation as shown in Fig. 61.2:

Figure 61.2 Window Decay calculation
To calculate activity for a date, specify the original activity in field Original activity,
specify original and target date and time and click button Calculate. The activity for the new date
will appear in field Final activity. The new data including activity and date can be exported to the
main table by clicking button Apply. To close window Decay calculation, click button Cancel.
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14 Calibration for activity calculation by the ROI-method
14.1 General provisions
The ASW2 software enables calculation of (specific) activity of radionuclides in a count
sample by the ROI-method considering calibration files which contain calibration sensitivity
coefficients calculated in accordance with paragraph 14.4.
The software also enables direct calculation of calibration sensitivity coefficients.
Calibration of detection sensitivity of a spectrometer is performed by means of activity
reference samples featuring the shape of the count sample and gamma radiation absorption within
the count sample, alternatively, by means of special-purpose software for spectrum simulation by
the Monte Carlo method.
The calibration can be regarded to consist of the following stages:
– acquisition of spectra irradiated by reference activity samples or calculation of such
spectra by means of special purpose software which simulates interaction between
radiation and matter;
– acquisition of background spectrum;
– creating a *.clb calibration file and saving it.
The format of a *.clb file can be found in Appendix 1.
A proper calibration underlies correct and accurate measurements. This is why such an
operation shall be performed by a skilled expert, alternatively, an employee responsible for delivery
and adjustment of the spectrometer.
14.2 Creating a calibration file
14.2.1 Acquire spectra of reference samples or simulate these spectra be means of software
which implements calculation methods.
14.2.2 Load module Pack of spectra (see section 11).
14.2.3 Load all the calibration spectra into this module and then sort them, so that the spectra
of a radionuclide are grouped together (refer to the example in Fig. 49.
14.2.4 Make sure that the parameters of the samples’ spectra such as mass, volume, energy
calibration are correct, and background spectrum is chosen. These parameters are displayed in tab
Current-Parameters and additional tab Current- Additional (see Fig. 53, block 3).
14.2.5 Select tab Calibration in module Pack of spectra and specify a radionuclide, its
activity (in Bq) and the corresponding certification date for each spectrum in block Aprior activity
of current spectrum (see Fig. 2, block A).
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Block B
Block C

Block E

Block А

Figure 62
Block D

To this end, mark the first spectrum in the spectrum list (Fig. 62, block E) and click button
(see Fig. 62, block A). In column Nuclide of the string which will appear below, choose the
radionuclide from the drop-down list. Specify the activity or radionuclide concentration in the
reference sample in column Activity. Specify the certification date of the radionuclide activity or
to save the data. The procedure described is
concentration in column 'Date'. Then click button
applied to each spectrum in the main table (Fig. 62, block E).
If the drop-down list of column Nuclide is empty, load a radionuclide library by clicking
button
above the table (see Fig. 62, block A) and choosing a proper file in the standard dialog
box.
14.2.6 Choose appropriate geometry in field Geometry (Marinelli 1L, 0.25L vessel and so
on, see Fig. 62, block B).
14.2.7 In field Window (see Fig. 2, block C), specify the file which contains the data on the
energy regions to be considered in calculation (see paragraph 4.1 of Appendix 4).
14.2.8 If necessary, fill in field Comment.
14.2.9 Click button Calculate calibration.
14.2.10 All the calculated calibration sensitivity coefficients will appear as a tree structure in
field Calibration data (see Fig. 62, block D).
14.2.11 Click button Create file to save the calculation results as a calibration file (*.clb) to
disc (see Appendix 1).
14.2.12 By clicking button Create list of calibration spectra, one can create a calibration
spectra list file (*.lcs) which is used for activity calculation by the superposition method (see section
5.4). It is recommended to create separate folders for calibration spectra, background spectra and list
file.
14.3 Calibration for content calculation
In case the spectrometer should be calibrated in units of measurement different from Bq, for
example, mass fraction, percent and so on, the calibration procedure remains the same as described
in section 14.2. The certified values of the samples and their units of measurement are specified in
the table (Fig. 62, block A) with no changes according to paragraph 14.2.5. At the same time, one
must additionally edit the output calibration file (*.clb) and specify the proper units of measurement
in the string containing the radionuclide’s name as shown in the example below.
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…
4
Cs-137
1 1.000
K-40
1 1.000
Ra-226
1 1.000
Th-232
1 1.000

(Unit="kBq/sq.m")
(Unit="Bq/kg")
(Unit="%")
(Unit="ppm")

…
If the measurement unit is not specified, it is presumed to be Bq by default.
In order to obtain the result of calculation of radionuclide content in user’s units of
measurement, switch the calculation mode to Content (see section 2.4.4, Fig. 15).

14.4 Calibration coefficients
The ultimate goal of calibration of a spectrometric tract by the windows method is generation
of a matrix of calibration coefficients, each of which corresponds to the energy window,
radionuclide and density of a reference sample.
The number of energy windows is selected to be equal or exceeding the number of the
radionuclides used for calibration. The energy windows as such are determined by regions of
interest which are related to full energy peaks for each radionuclide used for calibration.
Calibration sensitivity coefficients are calculated in accordance with the formula for count rate
in each j:th window of an acquired spectrum of a count sample:

S j := ∑
i

Xi
⋅ S j i + S bj ,
Ai

i=1..m

(14.4.1),

where m is the number of unknown radionuclides in the count sample;
Xi is the unknown activity (to be calculated) of the i:th radionuclide in the count sample
featuring a certain density ρx, Bq (Bq/kg);
Ai is the activity of the i:th radionuclide in the “reference” sample featuring a certain density
ρx, Bq (Bq/kg);
S j i is the count rate in the j:th window of the “reference” spectrum of the i:th radionuclide
excluding the background count rate, cps;
S bj is the count rate in the j:th window of the background spectrum, s-1.

S ji
Value

Ai

in formula (14.4.1) is the sensitivity coefficient for window j, radionuclide i

and density ρx . Considering this, the formula for calculation of calibration sensitivity coefficient s is
as follows:

Cijr =

S jir
Ai r

, r =ρ0…ρd, (14.4.2)

73

where ρ0…ρd is the density of reference samples used for calibration, g/cm3;
Cijr is the sensitivity coefficient for window j and radionuclide i in the spectrum of a sample
featuring density r, cps/Bq (cps/Bq·kg);
ρ0…ρd are the density values of the reference samples used for calibration, g/cm3;
d is the number of density values used for calibration;
S j i r is the count rate in window j of the spectrum of reference sample with radionuclide i
featuring density r excluding background count rate, cps;
Air is the activity of radionuclide i in the reference sample featuring density r, Bq (Bq/kg).
For each measurement geometry, the result of calibration (a *.clb file) is an own matrix of
sensitivity coefficients in accordance with formula 14.4.2.

15 Quality assurance
To control metrological and technical performance of a spectrometric tract, control and test
measurements are performed, then the data obtained is saved, diagrams are plotted, reports are
created.
Quality assurance can include the following functions:
- adjustment of quality assurance parameters;
- gain test;
- energy calibration;
- efficiency and resolution test;
- sensitivity test;
- background test;
- Generation of reports and control diagrams which display monitoring results;
To perform qulaity assurance, click button
assurance (see. Fig. 63).

in the toolbar which opens window Quality
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Block 1
Block 2
Block 3
Block 4

Block 5

Figure 63. Tab ROI-method of window Quality assurance
This window provides a sequence of test measurements the results of which are used to
estimate how duly and correctly spectrometric tracts perform. The window contains 3 tabs: ROImethod, Peaks analysis and Report. Tab ROI-method implements control procedures relevant for
the ROI-method. This tab is usually used for low-resolution spectrometers. Tab Peaks analysis
implements control procedures relevant for the peak analysis method. This tab is usually used for
high-resolution spectrometers. Tab Report displays the results of the quality assurance procedures
performed.

15.1 Quality assurance (ROI-method)
Quality assurance by ROI-method is performed by means of tab ROI-method.
Quality assurance for a spectrometric tract consists of the procedures shown in Fig. 63,
namely: Gain adjustment, Energy calibration adjustment, Background test, Sensitivity test.
The parameters of these procedures are divided into groups. The procedures are implemented, one
after another, when this section is run.
Stage Gain adjustment sets a peak to the target channel by changing the gain factor for a
spectrometric tract in question. Since this procedure consists of a few iterations, Gain correction
factor (see section 2.4.2) is a very important parameter for it. Parameter Preset time for one
iteration sets the duration of a spectrum acquisition which provides the position of the target peak
to be set to the channel specified in field Target channel. The peaks are searched for within the
region around the target channel the boundaries of which are specified in field search in range±.
The procedure is finished when the target peak gets not farther than the value specified in field with
accuracy ± from the target channel (see Fig. 63, block 2).
In some special cases, it could be wise to treat a peak as a parabola rather than a Gaussian.
For example, this could be useful when searching for a quasi-centroid in an alpha spectrum acquired
by a ZnS(Ag) scintillation spectrometer-radiometer (see Fig. 64). In this case, tick box Peak
parabola.
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Figure 64. An alpha spectrum acquired by a ZnS(Ag) scintillation spectrometer-radiometer
Stage Energy calibration adjustment (Fig. 63, block 3) provides peak search within the
range specified and sets one of the energy values specified in an energy calibration file applied
(*.cen) for each peak found. Parameter Preset time for measurement sets the acquisition time for
the spectrum where the peaks are to be searched for. The range for peak search is set in field Peak
search range. The full name of the energy calibration file to be considered for peak search should
be specified in field Energy calibration file. For example, if the calibration file contains two points
– channel 220 (661.7 keV) and channel 830 (2614.5 keV) - then, in accordance with Fig. 63, peak
search in the spectrum measured will first be carried out between channels 120 and 320 and the
energy value of 661.7 keV will be set for the peak found, then peak search wil be carried out
between channels 730 and 930 and the energy value of 2614.5 keV will be set for the peak found. In
some cases, for example, when adjusting a tract of a beta spectrometer (see Fig. 65), it might be
necessary to carry out energy calibration considering only one point. In this case the calibration file
has to contain only one point.

Figure 65. A spectrum of radionuclides Sr-90+Y-90+Cs-137 acquired by a spectrometer based on a
plastic scintillator and the calibration window
Quality assurance stage Background test (Fig. 63, block 4) estimates how the background
spectrum measured has changed as compared to the background spectrum currently specified in
section Calculation parameters (see section 2.4.4). When implementing this procedure, the
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program estimates the discrepancy between count rates in the regions of interest in the background
spectrum newly measured and the spectrum specified as background taking into account the
statistical component. The result of this comparison (norm or significant discrepancy) will be
displayed in the status field and sent to the quality assurance report. Note that the acquisition time
for the background spectrum to be measured should be specified in field Preset time for
measurement, whereas the full name of the *.roi file which contains the energy regions where the
comparison will be carried out should be specified in field Zone file.
Quality assurance stage Sensitivity test (Fig. 63, block 5) estimates how the sensitivity of
the spectrometer has changed. When implementing this procedure, the program provides acquisition
of a spectrum of a control sample, calculation of activity of radionuclides and comparison of the
results obtained with the data specified in the certificate of the sample taking into account
uncertainty values. The result of this comparison (norm or significant discrepancy) will be displayed
in the status field and sent to the quality assurance report. Note that the acquisition time for the
control sample spectrum to be measured should be specified in field Preset time for measurement.
If the spectrum to be used for sensitivity control is the same as that used for adjustment of energy
calibration, one can make use of the spectrum acquired at stage Energy calibration adjustment. To
this end, tick box Use spectrum from energy calibration adjustment. In this case, no additional
spectrum acquisition for sensitivity control will be performed. The full name of the *.clb activity
calibration file which contains calibration coefficients for calculation of activity of the radionuclides
of the control sample (see section 5.1) should be specified in field Calibration file (ROI-method).
The full name of the *.pks passport data file of the control sample should be specified in field
Passport of source (see section 13).
When tab ROI-method is filled in (see Fig. 63), one can start the quality assurance
procedure. To start the measurements, click button Start in the bottom of the window. The program
will compile a scenario considering the parameters set and run the scenario. The current status is
displayed in the status field (see Fig. 63) to the right of the tab.
If one or more control operations (Gain adjustment, Energy calibration adjustment,
Background test, Sensitivity test) should be skipped, untick a box (or boxes) to the left of the
name(s) of the corresponding operation(s).
The results of implementation of the quality assurance scenario can be checked and analyzed
in a report (see Fig. 66) that is opened by clicking tab Report.
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Figure 66. Tab Report
Since ASW2 allows for measurements in several spectrometric tracts, this is wise to have
quality assurance parameters for each tract. To facilitate this, templates are used.
To create a parameter template for a spectrometric tract, specify properly the parameters and
click button
(see Fig. 63, block 1). Window Quality assurance templates (ROI-method) will
appear then (see Fig. 67).

Figure 67. Window Quality assurance templates (ROI-method)

Then click button
(Create a new template using the current parameters) in the toolbar
of this window. In the dialog box which will appear, specify the name of the new template and click
button ОК. The new template will appear in the list of window Quality assurance templates. To
open the parameters of a template, double click the template’s name in the list.

78

15.2 Quality assurance (peak analysis method)
Quality assurance by the peak analysis method is performed by means of tab Peaks analysis
(see Fig. 68).

Block 1
Block 2
Block 3
Block 4

Figure 68. Window Quality assurance, tab Peaks analysis
Similarly to the previous quality assurance method described in section 15.2, this tab
implements a sequence of test measurements the results of which are used to estimate correctness of
performance of spectrometric tracts. In this case, the processing methods are based on the peak
analysis method usually applied to high precision spectrometers featuring good resolution.
As shown in Fig. 68, the quality assurance by the peak analysis method consists of the
following tests: Gain adjustment, Resolution and efficiency test and Background test. The
parameters of these tests are divided into groups. These tests are carried out one after another when
this section has been started.
Quality assurance stages Gain adjustment and Background test are completely similar to
those carried out in accordance with the ROI-method (see section 15.1).
Quality assurance stage Resolution and efficiency test provides estimate of stability of such
spectrometric characteristics as peak position in the spectrum of a control sample, energy resolution
and detection efficiency in full energy peaks. To perform this stage of quality assurance, the user has
to specify acquisition time for a spectrum of the control sample in field Preset time for
measurement. This spectrum will be used to estimate the metrological characteristics mentioned.
Additionally, the reference spectrum of the control sample (*.asw) and the file of the passport data
(*.pks) of the source (control sample) should be specified in fields Reference spectrum with peaks
and Passport of source, respectively.
The reference spectrum of the control sample must have the data on peaks found, so that the
program can control the peak position, resolution and detection efficiency. This kind of data is
stored in the file which has the same name as the spectrum itself, but different extension (*.asr).
This file must be in the directory specified in field Reference spectrum with peaks. The spectrum
of the reference sample must be prepared in advance by means of ASW2, that is, energy calibration
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and peak shape and FWHM calibration should be carried out for this spectrum. Additionally, the
peaks should be added to the found peaks table. One should not choose too many peaks to avoid
excess of statistical data at the report stage. This is enough to consider peaks in the beginning,
middle and end of the energy range of the spectrum.
When the parameters in tab Peaks analysis are specified (see Fig. 68), the user can start the
quality assurance procedure by clicking button Start in the bottom of the window. The program will
compile a scenario considering the parameters set and run the scenario. The current status is
displayed in the status field.
If one or more control operations (Gain adjustment, Resolution and efficiency test,
Background test) should be skipped, untick a box (or boxes) to the left of the name(s) of the
corresponding operation(s) similarly to the quality assurance by the ROI-method.
The results of implementation of the quality assurance scenario can be checked and analyzed
in a report (see Fig. 69) that is opened by clicking tab Report.

Figure 69. Tab Report

To save the results and update the statistics of the characteristics, the data obtained can be
saved by clicking button Add to card (see Fig. 68, block 3). To check the statistics on the quality
assurance procedures performed earlier, open window Cards by clicking button Cards (see
Fig. 70).
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Block 1

Block 2

Block 3

Block 4

Figure 70. Window Cards
Window Cards contains a few blocks.
Block 1 contains a field with a drop-down list of parameters, namely, peak position,
resolution, efficiency, intensity. For the parameter chosen, charts showing its change over time will
be displayed, and the data on quality assurance procedures performed earlier will be exported from
the database and shown in the table in block 2 (Fig. 70).
In field Line of block 3, choose an energy from the drop-down list. The data in the chart will
be shown for this energy. Additionally, use the radiobuttons to specify the type of the card (X –
average, Rm – deviation). Considering the parameters set, the charts of the values measured and the
values of parameters CL (central line), UCL (upper control level), LCL (lower control level) will be
shown in block 4 (see Fig. 70). Additionally, the average value and the average deviation value are
shown in the panel above the chart (block 3).
In order to change the color of the charts, click button
one can set the colors for the charts (see Fig. 71).

. This opens a dialog box where

Figure 71. Window Chart parameters
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User can open the general record list which summarizes quality assurance procedures
performed earlier and saved by clicking button
window shown in Fig. 72.

in block 1 (see Fig. 70). This will open the

Figure 72. Window General record list
The window displays in a compact way all the data stored. Click button
to delete an
irrelevant record. Click button
to clear the list. Note that this will also delete the data from main
window Cards.

16 Licence
A standard version of ASW2 is protected by a USB license dongle. This means that the USB
license dongle should be inserted in the PC when the software is being launched or operated. The
root directory of the dongle must contain file sn_key.dat .The file mentioned contains the generated
coded data on the dongle in question. If there is no license data, the software will perform in the
demo mode during 10 minutes, then it will warn about demo version status and terminate the
operation. During this 10 minute demo mode, measurements cannot be started, and there will appear
messages warning about missing license.
Thus, ASW2 is in the demo mode if:
•
•
•

no USB licence dongle is inserted in the PC;
there is no sn_key.dat file in the root directory of the license dongle;
the USB licence dongle does not comply with the data contained in file sn_key.dat.
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17 Scenarium Module
17.1 Application
Module Scenarium presents the detached program, which could be launched from the program
ASW2 and separately as well. The module is intended for the sequences of spectrum procession
operations and other actions in the program ASW2. Module Scenarium also provides the remote access
to the program ASW2 by internet by the specified IP address.
As module Scenarium actually provides the access to the instruments of the program ASW2 by
protocol TCP/IP, the user could create own program modules which will send the commands identified
by the program ASW2. The list and description of the commands of module Scenarium, executed by
the program ASW2 is listed in section 17.6.

17.2 Start of Scenarium module
To launch the module Scenarium from the program ASW2 it is necessary to select the item
"Tools->Scenarium" in the main menu or start the program scen-mod.exe in work catalog of the
program ASW2.
At the start of scen-mod.exe with parameter "1", module interface will be in Russian, with
parameter "0" - in English. Also the parameter "connect" could be applied as a second one. In that case
after the module launch automatically will be made the attempt to connect the server. For example:
C:\asw2\Scen-mod.exe 2 connect

// Module start in manual mode with English
interface and automated connection

When module is opened, the window will appear on the screen as shown in Fig. 73.1.
Module Scenarium is connected to the program ASW2 via IP. At the start of the module
directly from ASW2, the automated connection is made and the sign “Connection with 127.0.0.1" (see
Fig. 73.1, block 4) appears. If connection is set up, the control buttons in the instruments panel will be
color as shown in Fig. 73.1 (block 1). Otherwise several buttons will be grey color.
If connection is absent it could be set up pressing the first button
in instruments panel of the
window Scenarium. The module Scenarium after the successful connection automatically will send the
require command for the presented in ASW2 spectrometric sections (GET_TRACTS_NAME), and
also make the control buttons in the instruments panel available.
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Block 1. Tool bar

Block 2. Script field

Block 4. Status bar

Figure 73.1. Main window of Scenarium module

Block 3. Status field

Application TCP/IP as data base exchange protocol provide possibility to send the
commands from the module Scenarium to the program ASW2 (server) by network in remote mode.
At the module start from the remote PC where the program ASW2 is not installed, the destination IP
address and computer (to connect and send commands) portal number should be specified. It should
be done with adjustment window (see Fig. 73.2), which is initiated by the button
in instruments panel.

(Parameters)

Figure 73.2. Access adjustment window to the program ASW2
17.3 Scenarium module interface
Fig 73.1 shows the outer views of the module Scenarium. In the upper part of the window
the instruments panel is placed (see Fig. 73.3):

Figure 73.3 Instruments panel of module Scenarium
The panel has the following buttons:

84

- Connection to server. Press this button and connect to the program ASW2 with
application of the parameters, shown in Fig. 73.2.
- Parameters, сall the window of parameters connection to the server (program
ASW2)
- Scenarium execution start. Pressing this button will start the module Scenarium,
start the execution of the commands (script) sequence, specified in the field below the instruments
panel (see Fig. 73.1, block 2).
- Stop scenarium execution. Pressing this button, the module Scenarium will stop the
current script as well as send the command BREAK to stop the executing command on the server.
- Open scenarium file. Call for the standard dialogue window to load saved before
scenarium file (*.srm).
- Save scenarium file. Call for the standard dialogue window to save to disc the
current scenarium of displayed in scenarium field (see Fig 73.1, block 2).
- Quality assurance (ROI-method). Call for the window Quality assurance (ROImethod), which provide the quality assurance procedures by the ROI-method procession (see
section 17.4).
- Quality assurance (peaks analysis method). Call for the window Quality
assurance (peaks analysis method), which provide the Quality assurance procedures by the peaks
analysis method (see section 17.5).
The script field is below the instruments panel in the window of the module Scenarium.
There the user is able to create its own script on the basis of the commands, available in the section
17.6.
To make the script compilation easier the user could apply so called tip for available
commands list. Press the buttons Ctrl+Space will display the drop dawn list of the commands,
available in the module. The user can select the required command in the list by the buttons arrows
on the keyboard and press Enter, then the specified command will appear in the script field (see
Fig. 73.4).
When the available command name is entered, the module automatically offers to enter the
command parameters in the specified sequence. It is organized as a pop-up tip (see Fig. 73.4).

Figure 73.4 Drop down commands list
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Figure 73.5. Pop up tip for command parameters and their order
The command parameters listed in the tip in square braсkets are not obligatory and could be
absent. Thus, for example, figure 73.5 shows the pop-up tip for the command
SET_ENERGY_CLB_CURSPC , set the energy calibration values where the first parameter of
the command is the number of dependence points to be set up. Further the second and the third
parameters of the command are the number of the channel and energy value of the first point. If the
first parameter of the present command is equal to 1, i.e. only one calibration point is specified, and
then no more parameters will be required. If the first parameter is equal to 2 and more than the
channel number value and energies for the point 2 and more accordingly should be specified.
Below the script field there is a state field. There the module Scenarium displays the data on
the current execution of the script, display the time clip of script start, sent commands and received
replies. Thus, Fig. 73.6 shows the state field view where the script execution result, comprising two
commands SET_PRESET and OPEN_SPC_FILE is shown.

Figure 73.6 Module window after script execution
The very bottom of the module Scenarium window has the state line where in the first field
the information on the connection to server state is specified (see Fig. 73.1, block 4).

17.4 Quality assurance (ROI-method)
The pressing the button
module opens the window Quality assurance (ROI-method) (see
Fig. 73.7). That window is intended for execution of test measurement sequence to form the results to
evaluate the correct operation of the spectrometric sections. The application of that chapter uses the
procession methods based on ROI-method, applied mainly for scintillation spectrometers of low
resolution.
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As shown in figure 73.7, the spectrometric section Quality assurance comprises several tasks
Gain adjustment, Energy calibration adjustment, Background test, Sensitivity test. Those tasks
parameters are collected in groups. The present tasks will be executed consequently at the start of the
present chapter.
The preliminary stage of control also is the setting of the present section where the
operations are executed (see Fig. 73.7, block 1).

Block 1

Block 6

Block 2

Block 3

Block 4

Block 5

Figure 73.7 Window Quality assurance (ROI-method)
The quality assurance stage Gain adjustment makes the setting ("adjustment") of peak into
the specified spectrum channel by the amplification factor change for the present spectrometric
section. As the present process is iteration one, the important parameter in the current adjustment is
Gain correction factor (see section 2.4.2). The parameter Measurement time of one iteration,s
shows the program the measurement time of one spectrum till the definition of the current position
of the searched peak which should be set up in position, specified in the field Target channel. The
peaks search is made in value range specified in the field search in range ± from target channel.
The adjustment is over when the peak is in the position of the target channel ± value specified in the
field with accuracy ± (see Fig. 73.7, block 2).
For some special cases there could be necessity to study the peak not as Gauss curve but as
parabolа. It could be useful for the search of quasi-centroid in the alpha radiation spectrum, received on
scintillation spectrometer based on ZnS(Ag) crystal (see Fig. 73.8).
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Figure 73.8 Alpha radiation spectrum on the spectrometer based on ZnS(Ag)
For this case the checkmark Peak parabola should be selected.
Quality assurance stage Energy calibration adjustment (Fig. 73.7, block 3) makes the peaks
search in the specified range and assigns them the adequate energy values, specified in energy
calibration file (*.cen). The parameter Measurement time,s indicates to the program the exposition
for spectrum measurement where peaks search will be made. The range (one for all peaks) for the search
of the peaks there are specified in the field Peaks search range. The path and energy calibration file
name, in accordance to which the peaks search will be done, should be specified in the field Energy
calibration file. Thus, for example, in accordance to figure 73.7, if the calibration file has two points
220 channel (661.7 keV) and 830 channel (2614.5 keV), then the program will search in the measured
spectrum he peak within the range of 170 – 270 channels and will assign it the energy value of 661.7
keV, then the peak search in the range of 780 – 880 channel will be made and the value of 2614.5 keV
will be assigned.
For some cases, for example, for the adjustment of beta spectrometric section (see Fig. 73.9),
possible adjustment of energy calibration only in one point could be required. Then the calibration file
should have only one point.

Figure 73.9 Radionuclides Sr-90-Y-90+Cs-137 spectrum on the spectrometer based on
scintillation plastic and calibration window by energy
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The Quality assurance stage Background test (Fig. 73.7, block 4) valuates the background
spectrum change in comparison to the current background spectrum specified in the section Calculation
parameters in the program ASW2 (see section 2.4.4). The content of the background control procedure
in the present operation is the same as shown in section 15 of the present document. Thus, the program
vauates the deviation of the count rate in the specified windows with the account of the statistical
component in measured again and current saved background spectrum. The result (norm or significant
deviation) are displayed in the state field as well as the report on the Quality assurance.
In the field Measurement time the exposition of the background spectrum acquisition for the
control should be specified. The path and file name (*.roi) with energy ranges to evaluate the deviations,
should be specified in the field Zone file.
The Quality assurance stage Sensitivity test (Fig. 73.7, block 5) makes the evaluation of the
spectrometer sensitivity change in time. The contents of the sensitivity control procedure in the present
operation are the same as listed in section 15 of the present document. The program makes the standard
sample spectrum measurement, calculates radionuclides activity and compares the obtained results to the
passport data for the samples with errors account. The result (norm or significant deviation) is displayed
in the state field as well as Quality assurance report.
The standard sample spectrum acquisition exposition should be specified in the field
Measurement time. If the standard samples for energy calibration and sensitivity control are the same,
then the spectrum obtained on the stage of Energy calibration adjustment could be applied. Then set
up only checkmark in indicator Use spectrum from energy calibration adjustment. The additional
measurement will not be done then.
The path and calibration file name (*.clb) are specified in the field Calibration file (ROImethod) by activity of calibration factors, which allow calculation of radionuclide activities in the
standard sample (see section 5.1). The source (standard sample) passport data file (*.pks) is specified in
the field Passport of source (see section 13).
When parameters in the window Quality assurance (ROI-method) (Fig. 73.7) are filled, the
user could start the control operations execution. The button Start in window bottom should be pressed,
and then the module will compile script on the basis of the specified parameters and will launch its
execution. The process of the executing operations could be seen in state field (see Fig. 73.10).
To secure the logic and remote access during the Quality assurance execution, the user should
not operate with spectra in the program ASW2 as it could result in the change of the current path or
close of the seen current spectrum.
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Displaying of the
process of the
quality assurance
implementation

Figure 73.10. State field in the process of Quality assurance
When the Quality assurance script is over, the user could see and analyze the control results in
the report (see Fig. 73.11) clicking the sign Quality assurance results… in the bottom of the window.

Figure 73.11. Report window
The necessity to have Quality assurance parameters for each path is obvious as the program
ASW2 provides measurements by several spectrometry sections. The concept «template» is applied to
simplify the task.
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To create the parameters templates for the present spectrometric path, the user should fill them
duely in the window Quality assurance (ROI-method). Then press the button
in instruments panel
of that window and the window with the name Quality assurance templates (see Fig. 73.12) will
appear.

Figure 73.12. Window Quality assurance templates
Further press the button
(Create a new template base on the current parameters) in
instruments panel of that window and enter the name of a new template in appeared dialogue
window. A new template will appear after pressing the button ОК in the list of the window Quality
assurance templates. To call the parameters of any template, its name should be clicked in the list
by double click.

17.5 Quality assurance (peak analysis method)
the module will open the window Quality assurance (peak
Pressing the button
analysis method) (see Fig. 73.13). Analogue to the previous type of test, described in section 17.4
of the present attachment, this window is intended for execution of test measurements sequence to
form the results for correct and duly operation of spectrometric paths. The application of the present
section applies the procession methods, based on peak analysis method, applied for precision
spectrometers with high resolution.
Block 1
Block 2
Block 3

Block 4

Figure 73.13. Window Quality assurance (peak analysis method)
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Figure 73.13 shows that the Quality assurance in spectrometric path for peaks analysis
method comprises the following tasks: Gain adjustment, Resolution and efficiency test,
Background test. Those tasks parameters are collected in groups. The present tasks will be
executed sequentially at the start of the present section.
The preliminary stage of the control is the setting of the specified path where operations will be
executed (see Fig. 73.13, block 1).
The Quality assurance stages Gain adjustment and Background test are absolutely identical to
the Quality assurance by ROI-method (see section 17.4).
The Quality assurance stage Resolution and efficiency test is intended to evaluate permanence
and repeatability of spectrometric characteristics as peaks position in standard sample, energy resolution
and registration efficiency of gamma quanta by full absorption peaks. Within the frames of the present
control the user should fill the field Preset time for measurement, s , where standard sapmple
measurement exposition, which is applied to value the mentioned metrological characteristics, is
specified. Also the reference spectrum of the control sample (*.asw) in the field Reference spectrum
with peaks should be specified as well as the source (standard sample) passport data file (*.pks) in field
Passport of source. Reference spectrum of the standard sample should have marking, i.e. have
information of the searched peaks, used by the program to control the position, resolution and
efficiency. As information of the found peaks are in the file with the same name as the spectrum but
with resolution *.asr, the user should draw attention to the presence of that file in the catalogue, written
in the field Reference spectrum with peaks. Reference sample spectrum should be prepared before in
the program ASW2, i.e. energy calibration and calibration by FWHM and peak form should be made.
Also the peaks to the searched peaks table should be selected (added). A large peak number is not
recommended because it will provide the excess of the statistic information on the stage of result form
in the report. With the account of the radionuclides in the available control sample it is enough to have
the points at the beginning, middle and end of energy range.
When parameters in the window Quality assurance (peak analysis method) is filled
(Fig. 73.13) the user start the control operations. The button Start in the bottom of the window should
be pressed, then the module will compile the script based on the specified parameters and will start its
execution. The executing operations run could be seen in state field.
When Quality assurance script is over, the control results could be seen and analyzed in the
report (see Fig. 73.14) activating it by the sign Quality assurance results… in the window’s bottom.

Figure 73.14. Window Report

92

To save the results and update the statistics of the characteristics, the data obtained can be
saved by clicking button Add to card (see Fig. 73.13, block 3). To check the statistics on the quality
assurance procedures performed earlier, open window Cards by clicking button Cards (see
Fig. 73.15).

Block 1
Block 2

Block 3

Block 4

Figure 73.15 Window Cards
Window Cards contains a few blocks.
Block 1 (see Fig. 73.15) contains two fields. The first field contains a drop-down list where
a spectrometric tract can be selected. The second field contains a drop-down list of parameters,
namely, peak position, resolution, efficiency, intensity. For the parameter chosen, charts showing its
change over time will be displayed, and the data on quality assurance procedures performed earlier
will be exported from the database and shown in the table in block 2 (Fig. 73.15).
In field Line of block 3, choose an energy from the drop-down list. The data in the chart will
be shown for this energy. Additionally, use the radiobuttons to specify the type of the card (X –
average, Rm – deviation). Considering the parameters set, the charts of the values measured and the
values of parameters CL (central line), UCL (upper control level), LCL (lower control level) will be
shown in block 4 (see Fig. 73.15). Additionally, the average value and the average deviation value
are shown in the panel above the chart (Fig. 73.15, block 3).
In order to change the color of the charts, click button
one can set the colors for the charts (see Fig. 73.16).

. This opens a dialog box where

Figure 73.16. Window Chart parameters
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17.6 Scenarium module commands
When script is formed the several rules should be observed:
- all commands should start from the first symbol of line in script field;
- no empty lines between the lines with commands;
- only one command in one line;
- no spacings when commands parameters are specified;
- no spacings and punctuation marks in the name of a command.
The following nominations are used at each line formation:
COMM AND(Param1:string,[Param2:integer])

COMMAND – command name.
Param1 and Param2 – command parameters. Parameters, marked with square brackets,
could be absent.
string, integer – parameter type:
string – line, symbols set except the comma;
integer – integer-valued;
real – real.
Program ASW2 will revert the line when any command is over:
COMMAND=OK#10#13
For example, reply to the command SET_TRACT(BOSON,BDEG) will be as follows:
SET_TRACT=OK#10#13
If the command is not immediate, i.e. continuous, the program ASW2 will first return the line:
COMMAND=DO#10#13
and then, after it is over
COMMAND=OK#10#13
If the commands were executed with error, for example, due to incorrect parameters, the reply
will be as follows:
COMMAND=ER#10#13
#10#13 – ASCII symbols of line end LF(line feed) and CR (carriage return) accordingly. If
the command means the return of any result, the reply will be as a line and format depends on the
command itself (see commands description below).
For example, the full reply to the command FIND_PEAK_FOR_EN(100,300,661.7,0) will be
as follows:
FIND_PEAK_FOR_EN> CH=220.5
FIND_PEAK_FOR_EN=OK
Each line, returned by the server, has the symbols combination at the end #10#13.

The program ASW2 provide execution of the following commands:
SET_TRACT(MCA_name:string,Channel_name:string)
The command of path set up with the name Channel_name in analyzer MCA_name current.
MCA_name – the name of the analyzer, specified in the program ASW2;
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Channel_name – the name of the channel, specified in the program ASW2 for the analyzer
with the name MCA_name.

BREAK
Command to break the current executing command. If no command is running, the command
is ignored.
START
Command to start measurement in the current path.
STOP
Command to stop measurement in the current path.
SET_PRESET(Time_sec:integer)
Command to set up the measurement time for the current pathа.
Time_sec – measurement time, s.
PAUSA(Time_sec:integer)
Command to pause in the script with duration Time_sec.
Time_sec – pause duration, s.
ADJUST_GAIN(Left_border:integer,Right_border:integer,Target_channel:integer,
Allowed_deviation:integer,Time_sec:integer)
Command to start amplification adjustment procedure for the current path. It sets up the
searched peak in the specified range in the target channel by iteration method, changing
theamplification factor (or control voltage in dependence on analyzer type). The adjustment
procedure stops when the peak is in the range of Target_channel ± Allowed_deviation.
Left_border, Right_border – left and right interval boarder in a spectrum, where peak search
will be made, channel;
Target_channel – target channel where the program will try to set up the searched peak;
Allowed_deviation – allowed deviation from the target channel where the procedure will be
stopped, channel;
Time_sec – measurement time of one iteration at the fitting of a peak, s.
ADJUST_GAIN_PARAB(Left_border:integer,Right_border:integer,Target_channel:intege
r,Allowed_deviation:integer,Time_sec:integer)
Command executes the analogue procedure as ADJUST_GAIN, but at the peak procession
with the aim to define centroid as a descriptive function is not Gauss function but a parabola.
FIND_PEAK_FOR_EN(Left_border:integer,Right_border:integer,Energy:real,Type:intege
r,[Num_point:integer] )
Command makes the peak search in the specified interval for the current spectrum.
Additionally in dependence on the type specified in a parameter Type the command makes the
following functions:
Type = 0 - no functions;
Type = 1 - adds point to calibration by energy for the present spectrum and makes the
recalculation of the functional dependence for the current spectrum;
Type = 2 - corrects the value of the point in calibration by energy with a number
Num_point for the present spectrum and makes the recalculation of the
functional dependence for the current spectrum and current path.
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For the case Type = 1 or Type = 2 the value Energy is taken as the energy value for a new or
correcting point in calibration. For the case Type = 0 or Type = 1 the value Num_point should not be
specified.
Left_border, Right_border – the left and the right interval boarder in a spectrum,
where the peak search will be done, channel.
If the peak is found, the command returns the result as a line:
FIND_PEAK_FOR_EN > CH=220.5
FIND_PEAK_PARAB_FOR_EN(Left_border:integer,Right_border:integer,Energy:real,T
ype:integer,[Num_point:integer] )
Command makes the analogue procedure as FIND_PEAK_FOR_EN, but at the peak
procession with the aim to define centroid as a descriptive function is not Gauss function but
parabol.
OPEN_SPC_FILE(Spc_filename:string)
Command opens the spectrum with the name Spc_filename. If the path for the present file is
not specified then the program will search the spectrum in the catalogue by default, specified in a
section Calculation parameters (see section 2.4.4).
SAVE_CUR_SPC_FILE(Spc_filename:string)
Command saves the current spectrum under the name Spc_filename.
CALC_ROI_METHOD
Command calculates radionuclide activity by ROI-method for the current spectrum with the
application o fthe calibration file and background spectrum, specified in the present current
spectrum. Actually the present command emulates the button press
method) (см. Section 5.1 the present document).

-> Calculation (ROI-

SET_CLB_FILE_CURSPC(Clb_filename:string)
Command links the calibration file Clb_filename (*.clb) with the current spectrum. When the
present command is executed in the window Spectrum parameter for the current spectrum in the
field Calibration file (ROI-method) will be specified Clb_filename. If the path for the present
calibration file is not specified, the program will search that file in the calibration catalogue by
default, specified in the section Calculation parameters (see section 2.4.4).
SET_BKG_FILE_CURSPC(Bkg_filename:string)
Command sets up the spectrum file Bkg_filename as background for the current spectrum.
After the execution of the present command in the window Spectrum parameters for the current
spectrum in the field Background spectrum the file Bkg_filename will be specified. If the path for
the spectrum Bkg_filename is not specified, then the program will search that file in the background
catalogue by default, specified in the section Calculation parameters (see section 2.4.4).
SET_EFP_FILE_CURSPC(Efp_filename:string)
Command links the efficiencies file Efp_filename (*.efp) with the current spectrum.
After the execution of the present command in the window Spectrum parameters for the current
spectrum in the field Efficiency file will be specified the file Efp_filename. If the path for the file
Efp_filename is not specified, the program will search that file in calibration catalogue by default,
specified in the section Calculation parameters (see section 2.4.4).
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SET_LBR_FILE_CURSPC(Lbr_filename:string)
Command links library file Lbr_filename (*.lbr) with the current spectrum. After the
execution of the present command in the window Spectrum parametersа for the current spectrum in
the field Library the file Lbr_filename will be specified. If the path for the file Lbr_filename is not
specified, then the program will search that file in the calibration catalogue by default, specified in
the section Calculation parameters (see section 2.4.4).
SET_ZONES_FILE_CURSPC(Zones_filename:string)
Command links the region of interests file Zones_filename (*.roi) with the current spectrum.
After the execution of the present command in the window Spectrum parameters for the current
spectrum in the field Region of Interest file the file Zones_filename will be specified. If the path is
not specified for the file Zones_filename, the program will search that file in the calibration
catalogue by default, specified in the section Calculation parameters (see section 2.4.4).
SET_CLB_FILE_TRACT(Clb_filename:string)
Command analogue to SET_CLB_FILE_CURSPC, but the action refers to the current path.
After the execution of the present command the file Clb_filename will be specified in the field
Calibration file (ROI-method) in the window Calculation parameters (see section см. разд.2.4.4).
SET_BKG_FILE_TRACT(Bkg_filename:string)
Command analogue to SET_BKG_FILE_CURSPC, but the action refers to the current path.
After the execution of the current command the file Bkg_filename will be specified in the field
Background spectrum in the window Calculation parameters (see section 2.4.4).
SET_EFP_FILE_TRACT(Efp_filename:string)
Command analogue to SET_EFP_FILE_CURSPC, but the action referse to the current path.
After the execution of the present command the file Efp_filename wуill be specified in the field
Efficiency file in the window Calculation parameters (see section 2.4.4).
SET_LBR_FILE_TRACT(Lbr_filename:string)
Command analogue to SET_LBR_FILE_CURSPC, but the action refers to the current path.
After the execution of the present command the file Lbr_filename will be specified in the field
Library in the window Calculation parameters (see section 2.4.4).
SET_ZONES_FILE_TRACT(Zones_filename:string)
Command analogue to SET_ZONES_FILE_CURSPC, but the action refers to the current
path. After the execution of the present command the file Zones_filename will be specified in the
field Region of interests file in the window Calculation parameters (see section 2.4.4).
PEAKS_CLEAR_ALL
Command clears the list of the searched peaks in the current spectrum (see p.6.4 of the
present document).
PEAKS_FIND_NEW
Command searched the peaks in the current spectrum in accordance to its parameters and
modes (see p.6.2.8 of the present document).
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PEAKS_UPDATE
Command updates the characteristics of the searched peaks in the current spectrum in
accordance to its parameters and modes (see p.6.3 of the present document).
PEAKS_FIND_PARAMS(Left_border:integer,Right_border:integer,Min_sq:real,Type_sea
rch:integer,Smoothing_range:integer,Smoothing_count:integer,MTP:real,Energy_dev:real)
Command of the parameters setting for the correct activity calculation by the peak analysis
method (see p.6.1 of the present document).
Left_border, Right_border – left and right interval boarders where the peaks search is made,
channel;
Min_sq – minimal peak area to discard the peaks in search process, pulses;
Type_search – search type: 0 – search and identification, 1- peaks of library;
Smoothing_range – smoothing polynomial degree (2-6);
Smoothing_count – smoothing iterations quantity;
MTP – peak thickness multiplier (3-10);
Energy_dev – energy deviation, where in the limits the peak could be recorded by a
characteristic line of a certain radionuclide, keV.
SEND_DB(N_protokol:string,Customer:string)
Command to send all measurements results in data base.
N_protokol – protocol number;
Customer - customer name.
SEND_WORD (Type_calc:integer)
Command to send the measurements results table into the editor MS Word. In dependence
to the parameter Type_calc the data will be sent to MS Word from the calculation table by ROImethod and calculation table by peaks analysis:
Type_calc – results table search: 0 – ROI-method, 1- peaks analysis method.
SEND_REPORT(Type_calc:integer,DoPrintNow:integer)
Command opens master report window and compiles the report for the current spectrum in
accordance to the current parameters (see p.5.1). In dependence to the parameter Type_calc data will
be sent to MS Word from calculation table by ROI-method and calculation table by peaks analysis
method:
Type_calc – results table selection: 0 – ROI-method, 1- peaks analysis method;
DoPrintNow – parameter, pointing the necessity of report immediate print: 0 - do not print,
1- print right now.
SET_REPEAT_MEAS_PARAM(IsOn:integer,Iteration_count:integer,Pausa:integer,
Template:string,Directory:string)
Command allows to specify the parameters of the repeated measurements (see p.2.4.3) for
the current path.
IsOn – switch on (IsOn=1)/switch off (IsOn=0) measurements repetition mode;
Iteration_count – measurements repetition quantity;
Pausa – pause duration between the measurements, s;
Template – template for spectrum name file;
Directory – path to the catalogue where the measured spectra are saved in the catalogue.
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SET_HV(IsOn:integer,Value_HV:integer,Type_value:integer)
Command for high voltage ON and OFF for the current path.
IsOn – switch on (IsOn=1)/switch off (IsOn=0) of high voltage;
Value_HV – target value of the setting high voltage. In dependence on analyzer type
Value_HV could be so called control voltage (See Analyzer Manual).
Type_value – value type Value_HV. 0 – high voltage, 1 – control voltage.
SET_ENERGY_CLB_TRACT(Point_count:integer,Ch1:integer,En1:integer,[Ch2:integer
,En2:integer,Ch3:integer,En3:integer] )
Command executes the setting for energy calibration points values for the current path and
automatically recalculates a new functional energy dependence on the channel.
Point_count – number of the point to be set up. In dependence on these parameter the
number of channel-energy pairs are defined as parameters for the present command.
Ch1, Ch2, Ch3 etc. – the channel number in a spectrum for the point under number 1, 2, 3
etc. accordingly;
En1, En2, En3 – energy for the point under number 1, 2, 3 etc accordingly.
For example:
Command SET_ENERGY_CLB_TRACT(3,220,661.7,677,1173.2,820,2614.5) provides
energy calibration as shown in Fig. 73.17:

Figure 73.17. Window Energy calibration
SET_ENERGY_CLB_CURSPC(Point_count:integer,Ch1:integer,En1:integer,[Ch2:intege
r,En2:integer,Ch3:integer,En3:integer] )
Command analogue to SET_ENERGY_CLB_TRACT, but the action refers to the current
spectrum.
TEST_BKG(Zones_filename:string,[Base_bkg_filename:string])
Command executes the procedure of background control for the current spectrum. In case if
optional parameter Base_bkg_filename is not specified, the current spectrum will be compared to the
current background spectrum for the present path.
Zones_filename – region of interests file (*.roi). Statistic comparison will be made by energy
intervals specified in that file.
Base_bkg_filename – background file, which could act as basic one instead of current path
background spectrum.
Command provides the result as a message:
TEST_BKG> OK
What means that the background is normal, or :
TEST_BKG> DEV=nn
What means the background is out of a norm and deviation is significant and is equal to
nn%.
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TEST_SENS(Clb_filename:string,Pks_filename:string,[Base_bkg_filename:string] )
Command executes the sensitivity control procedure for the current spectrum. In case the
optional parameter Base_bkg_filename is not specified, the control will be made with the account of
the current background spectrum for the present path.
Clb_filename – calibration file for activity calculation by ROI-method (*.clb);
Pks_filename – passport data file for a source (reference sample) (*.pks);
Base_bkg_filename – background spectrum, which could act as a basic one instead of
current path background spectrum.
Command provides the result as a message:
TEST_SENS> OK
What means that sensitivity is normal, or :
TEST_SENS> RN1(Cs-137)=nn1, RN2(Ra-226)=nn2,
What means that sensitivity is out of a norm and deviation is significant for radionuclide
number number 1 and number 2 and makes nn1% and nn2% accordingly. In brackets at key word
RN1 and RN2 the name of radionuclide and deviation is specified.
TEST_SENS_TEMP(Num_saved_spc:integer;Clb_filename:string,Pks_filename:string,
[Base_bkg_filename:string] )
Command analogue to TEST_SENS, but the action refers not to the current spectrum but to
the spectrum saved in memory by the command STORAGE_CURSPC_TEMP.
Num_saved_spc – spectrum number saved in the memory of the program ASW2.
STORAGE_CURSPC_TEMP(Num_spc:integer)
Command of the current spectrum record into the program memory under the number
Num_spc. Parameter Num_spc should be equal not more than 2.
TEST_RESEFF(Etalon_spc_filename:string,Pks_filename:string)
Command executes the control procedure of resolution and efficiency for the current
spectrum.
Etalon_spc_filename – name and path to reference sample standard spectrum file. The
present spectrum should have marks, i.e. the file with the same name and extension *.asr should be
in the same catalogue as reference spectrum, (see p.6.2.11);
Pks_filename – passport data for a source (reference sample) (*.pks). Command provides
the result as a message:
TEST_RESEFF> OK
What means, that resolution and efficiency are normal, or :
TEST_RESEFF> NOT_OK
What means the resolution and efficiency are out of a norm.
With no dependence to positive or negative result of a test the info line will follow:
TEST_RESEFF> DATA PEAK1(en,ch_et,ch,ch_Ok,res_et,res,res_Ok,eff_et,eff,eff_Ok),
PEAK2(en,ch_et,ch,ch_Ok,res_et,res,res_Ok,eff_et,eff,eff_Ok),…
where en – line energy, keV;
ch_et – peak position in standard spectrum, channel;
ch – peak position in the current spectrum, channel;
ch_OK – feature of negligible deviation of peak position: 0 – deviation is out of a norm, 1normal;
res_et – peak resolution in spectrum of a standard, keV;
res – peak resolution in the current spectrum, keV;
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res_OK – feature of negligible resolution deviation: 0 – deviation is out of a norm, 1normal;
eff_et – efficiency by a peak in spectrum of a standard, channel;
eff – efficiency by peak in the present spectrum, channel;
res_OK – feature of neglibible efficiency deviation.

For example:
TEST_RESEFF> DATA PEAK1(661.7,220.0,220.1,1, 1.7,1.8,0,0.0021,0.0021,1),
PEAK2(1332.5,770.0,770.1,1, 1.5,1.5,1,0.0018,0.0018,1), This reply means that the standard
spectrum marks have two peaks with energies 661.7 keV and 1332.5.
WAIT_MEAS_END
Command executes waiting for the completion of the current measure for the current path.
In case if the measurement is not over the commands will be as follows:
WAIT_MEAS_END=DO
At a moment when measurement is over or stopped, the program will return the command:
WAIT_MEAS_END=OK
GET_TRACTS_NAME
Request command for the list of the available spectrometric paths in the program ASW2. In
reply to the present command the reply will return as follows:
GET_TRACTS_NAME> DATA TRACT1(name_mca,name_channel),
where
TRACT2(name_mca,name_channel), TRACT3(name_mca,name_channel),
name_mca – analyzer name;
name_channel – channel name in analyzer name_mca.
For example:
GET_TRACTS_NAME> DATA TRACT1(BOSON,GCD-4020),
TRACT2(BINOM,BDEG-63-63), TRACT3(BINOM,BDEG-76-76),
That reply means that at the present moment in the program ASW2 in devices manager (see
Fig. 1, block 3) has three paths: one analyzer with the name BOSON with one path with the name
GCD-4020, and one analyzer BINOM with two paths BDEG-63-63 and BDEG-76-76.
REQUEST_MESSAGE(Str:string,[Caption:string] )
The present command does not send the request to the program ASW2, but just stops the
execution of the script, started from the module Scenarium and provides the message, specified in
Str. Optional parameter Caption allows to put the line in the name of the message in dialogue
window.
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Appendix 1. Calibration file structure (*.clb)
The content of the calibration file is italicised.
Marinelli
ADC Polynom S/N 16
BDEG-63-63

Name of geometry of measurements
Three rows for any comments

6

Number of working windows
Bottom and top edges of work windows, as well as
coefficients of shielding for each density and window.

612.0
709.0 0.99 0.97 0.95
870.0 1000.0 0.99 0.97 0.95
1068.0 1178.0 0.98 0.95 0.92
1385.0 1540.0 0.99 0.97 0.95
1677.0 1846.0 0.99 0.97 0.95
2500.0 2720.0 0.99 0.97 0.95
4
Ra-226
(Unit="kBq/sq.m")
3 0.200 0.900 1.700
Th-232
3 0.200 0.900 1.700
K-40
3 0.200 0.900 1.700
Cs-137
3 0.200 0.900 1.700

Number of radionuclides in the matrix
Radionuclide and units of measurement
Number of attested densities and density in g/cm3

0.012518
0.012386
0.011181

0.004974
0.004851
0.004716

0.006181
0.005869
0.005408

0.004008
0.003725
0.003491

0.004754
0.004530
0.004011

0.000082
0.000085
0.000103

0.008251
0.007594
0.007546

0.016280
0.014390
0.013330

0.002369
0.002190
0.002031

0.002162
0.001980
0.001896

0.001555
0.001367
0.001381

0.004037
0.003551
0.003587

0.000385
0.000364
0.000343

0.000529
0.000570
0.000473

0.000504
0.000556
0.000474

0.001908
0.002064
0.001720

0.0
0.0
0.0

0.0
0.0
0.0

0.030660
0.028320
0.027240

0.000012
0.000020
0.000025

0.000003
0.000006
0.000008

0.0
0.0
0.0

0.0
0.0
0.0

0.0
0.0
0.0

Sensitivity,
for
the
first
nuclide (сps/Bq)
in work windows
(rows) and for
each
density
(columns)
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Appendix 2. Efficiency file structure (*.efp)
Efficiency Eff calculation for energy En is made using the formula:
Eff(En)=Exp[A0+A1*lnEn+A2*(lnEn)2+A3*(lnEn)3+A4*(lnEn)4+A5*(lnEn)5 +A6*(lnEn)6].
[Main]
Count=3

Main block heading.
Number of densities.

[Item_1]
En_1=50
En_2=3000
Geometry=Marinelli
Ro=0.19
dA=0.000120673701486547
A0=100.952521999333
A1=-193.624766139809
A2=113.539550219905
A3=-31.4152431368484
A4=4.55284676290508
A5=0
A6=0
A_up0=-239.089407209938
A_up1=154.712894929183
A_up2=-37.6090565833576
A_up3=4.0180585277374
A_up4=-0.160073518024323
A_up5=0
A_up6=0
A_down0=-242.411794019549
A_down1=156.961174786668
A_down2=-38.1739234808294
A_down3=4.07993324404847
A_down4=-0.162573133753684
A_down5=0
A_down6=0

First curve block heading.
Interval of energies
which the curve corresponds to.
The geometry the curve was made for
Density corresponding to the first curve.
First error approximation error.
Coefficient A0
Coefficient A1
-//-//-//-//-//-

Polynomial coefficients of the upper boundary of
the confidence interval of the efficiency curve

Polynomial coefficients of the lower boundary of
the confidence interval of the efficiency curve

Count_point_eff=8
Point_eff1=Ra-226;186.1;0.0289146;0.036
Point_eff2=Ra-226;241.98;0.0230479;0.036
Point_eff3=Ra-226;295.21;0.0201344;0.036
Point_eff4=Ra-226;351.92;0.0176451;0.036
Point_eff5=Ra-226;609.31;0.01006;0.036
Point_eff6=Ra-226;768.36;0.00867296;0.036
Point_eff7=Ra-226;1120.3;0.00628238;0.036
Point_eff8=Ra-226;1764.5;0.00447472;0.036
[Item_2]
Ro=1
dA=6.98283591165722E-5
A0=-472.240982213604
A1=394.832631929211
A2=-135.275425911041
A3=24.0371788273522
A4=-2.32009207827529
A5=0.113556756070361
A6=-0.00213719932431744
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Appendix 3. Passport of source file structure (*.pks)
The content of the passport of source file is italicised. The file has a structure of a standard
INI file.
[Main]
Count_nuclide=4
Date_reference=43412.9568

Main section name.
The number of radionuclides in the calibration
sample.
The date which the activities are specified
for.

Massa=0.314
Volume=0.25
Unit_weight=kg
Unit_volume=l
Geometry=Marinelli
Number=11/17

Mass of the source.
Volume of the source.
Mass unit.
Volume unit.
Name of geometry
Table number of source

[Nuclide_1]
Activity=5400
Abs_Err=540
Name=Ra-226

First radionuclide section name.
Activity, Bq.
Absolute error, Bq.
First radionuclide name.

[Nuclide_2]
Activity=2100
Abs_Err=210
Name=Th-232

Second radionuclide section name.
Activity, Bq.
Absolute error, Bq.
First radionuclide name.

…
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Appendix 7. Spectrometric tract stabilisation
7.1 Introduction
Various spectrometric tract stabilization methods are used on scintillation spectrometers to
increase the quality and reliability of the measurements. The present task could apply the outer
radiation sources and the inner ones. The stabilized light sources also could be applied. To adjust
the amplification or high voltage (control voltage) which compensate somehow or other the change
of peaks position in the spectrum from various factors, in ASW2 software there is a dialogue
window (Fig. A7.1), activated by the button
, specified in section 2.4.2 of the present
manual.

Figure A7.1

7.2 Application
The view of the window on the figure A7.1 and its contents directly depends on the analyser
type, activated for. Fig. A7.1 shows the window for BINOM analyser, manufactured by Baltic
Scientific Instruments company. If in the present spectrometer the stabilisation function for the
spectrometric tract is provided, then the present window will have tab “Stabilization”.
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Block 1

Block 2

Figure A7.2
In case the analyzer has built-in (hardware) stabilization function by reference peak then the
tab Stabilization will present the section Hardware stabilization with appropriate parameters (see
Fig. A7.2, block 1).
The parameters of the present chapter are:
Turn On – switcher indicating the program to apply the hardware stabilisation at the
measurements.
Left border, channel and Right border, channel – borders of search of reference peak in
the channels.
Target, ch - target channel, i.e. reference peak centroid position, where stabilization
system should hold it.
Area, count – peak area in pulses, where the correction of the tract amplification takes
place and a new iteration of statistics acquisition starts. The present parameter is described in more
details in Analyser Operation Manual.
Interval, s - time range, when the statistics acquisition is made for the reference peak.
When the specified time is over the program makes the adjustment of amplification and starts a new
cyсle for statistics acquisition for the present peak. The present parameter is described in more
details in Analyser Operation Manual.
Reference spectrum – switcher, indicating to the analyzer that stabilization should be
made by the reference spectrum. It is applied in case of LED stabilization when pulses of light
reference are redirected from the basic radiation spectrum into the reference spectrum.
The other stabilization type is a software one. It could be applied practically for any analyzer
at the spectrum stabilization by radiation peak in the spectrum. That peak could be the line of the
background radionuclide K-40 with energy 1460 keV or the peak of alpha radiation Am-241 source
built in scintillator.
To apply this stabilization type the operator should use the section Software stabilization.
The similar parameters of the present section have the same sense as in the chapter
Hardware stabilization, beside the sub-section Target: X(channel)=A+B·t.
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As position and reference peak dynamics (for example, alpha peak Am-241) could have
various behaviors from the temperature in comparison to the peaks dynamics of the measuring
radiation, the correction to temperature should be entered. ASW2 software apply the linear
dependence of the target position of reference peak on temperature:
X=A+B·t,
where X – target position of reference peak centroid, where the program should install it for
the current temperature t, channel;
A, B – experimental dependence coefficients, obtained on spectrometer commissioning;
t – current detector temperature, °C.
Thus, for example, for the case of the figure A7.2 at the current detector temperature of 30.8°С the
program will try to install reference peak in a position X=3806-6.041·30.8=3620 (channel). The
coefficients of the present dependence A and B are specified of the same names in the section
Target: X(channel)=A+B·t.
After changes are put into the parameters of the selected stabilization type, the button Apply
on the current tab should be pressed and decision should be confirmed. Then the adjustment window
could be closed and measurements could be started.
7.3 Gain correction factor
For the various types of the spectrometric devices and detectors even for the one typed, the
value of peak position change for amplification coefficient change unit could be various. That
parameter (Gain correction factor GCF) is mentioned in section 2.4.2 and shows how the
amplification should be changed (or control voltage) for the state when the peak under study is
shifted in one channel. The definition and installation of the present parameter is important
component in the adjustment procedure of the software stabilisation.
The algorithm of the present parameter calculation is as follows:
- set up the amplification coefficient (control voltage) so that the position of the peak under
study is in the main setting position;
- change the amplification coefficient so that the peak position changes in +30%
(approximately) and fix the value of amplification coefficient (K1) and peak centroid (X1);
- change the amplification coefficient so that the peak position changes in -30%
(approximately) on the main position and again fix the value of the amplification coefficient (K2)
and peak centroid (X2);
- define parameter GCF as ratio (K2-K1) to the change of the centroid position (X2-X1):
GCF = (K2-K1)/(X2-X1)
- specify the parameter value in the corresponding field Gain correction factor in the
window Tract configuration for the tract under study.
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